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 1
I n t r o d u c t i o n
The RF Module 3.4 is an optional package that extends the COMSOL 
Multiphysics® modeling environment with customized user interfaces and 
functionality optimized for the analysis of electromagnetic waves. Like all modules 
in the COMSOL Multiphysics family it provides a library of prewritten 
ready-to-run models that make it quicker and easier to analyze discipline-specific 
problems.

This particular module solves problems in the general field of electromagnetic 
waves, such as RF and microwave applications, optics, and photonics. The 
application modes (modeling interfaces) included here are fully multiphysics 
enabled, making it possible to couple them to any other physics application mode 
in COMSOL Multiphysics or the other modules. For example, to analyze 
stress-optical effects in a waveguide, you would first do a plane strain analysis using 
the Structural Mechanics Module followed by an optical mode analysis that shows 
the resulting split of the fundamental modes.

The underlying equations for electromagnetics are automatically available in all of 
the application modes—a feature unique to COMSOL Multiphysics. This also 
makes nonstandard modeling easily accessible.
 1



2 |  C H A P T E R  1
The documentation set for the RF Module consists of three books. The one in your 
hands, the RF Module User’s Guide, introduces you to the basic functionality in the 
module, reviews new features in the version 3.4 release, reviews basic modeling 
techniques and includes reference material of interest to those working in 
electromagnetics. The second book in the set, the RF Module Model Library, contains 
a large number of ready-to-run models that illustrate real-world uses of the module. 
Each model comes with an introduction covering basic theory, the modeling purpose, 
and a discussion about the results, as well as step-by-step instructions that illustrate 
how to set it up. Further, we supply these models as COMSOL Multiphysics Model 
MPH-files so you can import them into COMSOL Multiphysics for immediate 
execution. This way you can follow along with the printed discussion as well as use 
them as a jumping-off point for your own modeling needs. A third book, the RF 
Module Reference Guide, contains reference material about application-mode 
implementations and command-line functions and programming. It is available in 
HTML and PDF format from the COMSOL Help Desk.

Typographical Conventions

All COMSOL manuals use a set of consistent typographical conventions that should 
make it easy for you to follow the discussion, realize what you can expect to see on the 
screen, and know which data you must enter into various data-entry fields. In 
particular, you should be aware of these conventions:

• A boldface font of the shown size and style indicates that the given word(s) appear 
exactly that way on the COMSOL graphical user interface (for toolbar buttons in 
the corresponding tooltip). For instance, we often refer to the Model Navigator, 
which is the window that appears when you start a new modeling session in 
COMSOL; the corresponding window on the screen has the title Model Navigator. 
As another example, the instructions might say to click the Multiphysics button, and 
the boldface font indicates that you can expect to see a button with that exact label 
on the COMSOL user interface.

• The names of other items on the graphical user interface that do not have direct 
labels contain a leading uppercase letter. For instance, we often refer to the Draw 
toolbar; this vertical bar containing many icons appears on the left side of the user 
interface during geometry modeling. However, nowhere on the screen will you see 
the term “Draw” referring to this toolbar (if it were on the screen, we would print 
it in this manual as the Draw menu).

• The symbol > indicates a menu item or an item in a folder in the Model Navigator. 
For example, Physics>Equation System>Subdomain Settings is equivalent to: On the 
:  I N T R O D U C T I O N



Physics menu, point to Equation System and then click Subdomain Settings. 
COMSOL Multiphysics>Heat Transfer>Conduction means: Open the COMSOL 

Multiphysics folder, open the Heat Transfer folder, and select Conduction.

• A Code (monospace) font indicates keyboard entries in the user interface. You might 
see an instruction such as “Type 1.25 in the Current density edit field.” The 
monospace font also indicates COMSOL Script codes.

• An italic font indicates the introduction of important terminology. Expect to find 
an explanation in the same paragraph or in the Glossary. The names of books in the 
COMSOL documentation set also appear using an italic font.
 |  3



4 |  C H A P T E R  1
Ove r v i ew o f  t h e  R F Modu l e

This manual describes the RF Module, an optional add-on package for COMSOL 
Multiphysics designed to assist you in solving and modeling electromagnetic problems. 
Here you find an introduction to the modeling stages of the RF Module, including 
some realistic and illustrative models, as well as information that serves as a reference 
source for more advanced modeling.

What Can the RF Module Do?

The RF Module contains a set of application modes adapted to a broad category of 
electromagnetic simulations. Those who are not familiar with computational 
techniques but have a solid background in electromagnetics should find this module 
extremely beneficial. It can serve equally well as an excellent tool for educational 
purposes.

Because the RF Module is smoothly integrated with all of the COMSOL Multiphysics 
functionality, you can couple a simulation in this module to an arbitrary simulation 
defined in any of the COMSOL Multiphysics application modes. This forms a 
powerful multiphysics model that solves all the equations simultaneously.

You can transform any model developed with the RF Module into a model described 
by the underlying partial differential equations. This offers a unique way to see the 
underlying physical laws of a simulation. You can also export a simulation to COMSOL 
Script or MATLAB. Alternatively, save it as a Model M-file, a script file that runs in 
both COMSOL Script and MATLAB. This makes it possible to incorporate models 
with other products in the MATLAB family such as Simulink and the Control System 
Toolbox. 

What Problems Can You Solve?

The RF Module is a collection of application modes for COMSOL Multiphysics that 
handles time-harmonic, time-dependent, and eigenfrequency/eigenmode problems. 
The application modes fall into two main categories:
:  I N T R O D U C T I O N



• Propagation of electromagnetic waves

- Harmonic analysis

- Transient analysis

- Eigenfrequency/eigenmode analysis

• Propagation of light

- Harmonic analysis

- Transient analysis

- Eigenfrequency/eigenmode analysis

All categories are available in both 2D and 3D. In 2D the package offers in-plane 
application modes for problems with a planar symmetry as well as axisymmetric 
application modes for problems with a cylindrical symmetry. It further provides four 
application modes for 3D harmonic wave propagation in one direction, which can be 
formulated as 2D equations.

One major difference between quasi-static and high-frequency modeling is that the 
formulations depend on the electrical size of the structure. This dimensionless measure 
is the ratio between the largest distance between two points in the structure divided by 
the wavelength of the electromagnetic fields.

For simulations of structures with an electrical size in the range up to 1/10, 
quasi-static formulations are suitable. The physical assumption of these situations is 
that the currents and charges generating the electromagnetic fields vary so slowly in 
time that the electromagnetic fields are practically the same at every instant as if they 
had been generated by stationary sources. For electrostatic, magnetostatic, and 
quasi-static electromagnetics, use the AC/DC Module, a COMSOL Multiphysics 
add-on module for low-frequency electromagnetics.

When the variations in time of the sources of the electromagnetic fields are more rapid, 
it is necessary to use the full Maxwell application modes for high-frequency 
electromagnetic waves. They are appropriate for structures of electrical size 1/100 and 
larger. Thus, an overlapping range exists where you can use both the quasi-static and 
the full Maxwell application modes.

Independently of the structure size, the RF Module accommodates any case of 
nonlinear, inhomogeneous, or anisotropic media. It also handles materials with 
properties that vary as a function of time as well as frequency-dispersive materials.

Examples of applications you can successfully simulate with the RF Module include 
waveguides, photonic crystals, antennas, and transmission lines. For a more detailed 
O V E R V I E W  O F  T H E  R F  M O D U L E  |  5



6 |  C H A P T E R  1
description of some of these applications, refer to the matching book that comes with 
this product, the RF Module Model Library.

New Features in the RF Module 3.4

This release of the RF Module 3.4 adds a number of valuable new capabilities including 
these new features:

• Lumped ports with voltage excitation in transient analysis for supplying a voltage 
signal to, for example, a circuit board or an antenna. See “Lumped Ports with 
Voltage Input” on page 67.

• Support for multiple numerical ports in models. See “Numeric Modes” on page 58

• Periodic boundary condition in the in-plane and electromagnetic wave application 
modes that greatly simplifies the process of modeling periodic boundaries, especially 
for 3D electromagnetic waves. See “Periodic Boundary Conditions” on page 37.

• Faster and easier far-field postprocessing. See “Far-Field Postprocessing” on page 
49.
:  I N T R O D U C T I O N



App l i c a t i o n  Mode S umma r y

An application mode in COMSOL Multiphysics is a specification of the equations and 
the set of dependent variables you want to solve for and an interface adapted to the 
application (do not confuse the COMSOL Multiphysics application mode with the 
mode analysis, which is an analysis type for confined waves). When you have selected 
the application mode, you can also choose an analysis type. However, you can also 
change this later in the COMSOL Multiphysics user interface. The available analysis 
types are time-harmonic, time-dependent (transient), eigenfrequency, and mode 
analysis. Below you first find a short introduction to the field variables (dependent 
variables) in some of the 2D application modes. Following that is a section with some 
general details about the two analysis types in time-dependent problems. Finally, there 
is a summary with a short description of all the application modes in the RF Module.

Field Variables in 2D

When you want to solve for a vector field in 2D you usually get two different cases. 
For electromagnetic waves the cases are in-plane waves and perpendicular waves (only 
in-plane waves exists for axial symmetry). “In-plane” means that the current flows or 
the wave travels parallel to the cross section.

In wave propagation there are application modes for transverse electric (TE), 
transverse magnetic (TM), and hybrid-mode waves. For in-plane propagation, the 
wave propagates parallel to the 2D cross section. The plane with a constant phase is 
then perpendicular to the cross section. The analysis types are eigenfrequency analysis, 
harmonic propagation (time-harmonic analysis), and time-dependent analysis. Models 
using axial symmetry have the same application modes and analysis types. A typical 
example of axisymmetric wave propagation is the coaxial cable, where the wave 
propagates along the cable in the z direction. In the perpendicular application mode, 
the waves propagate perpendicular to the cross section. So viewing the 2D cross 
section, you look in the direction of the propagating wave. The analysis types are mode 
analysis and eigenfrequency analysis. In mode analysis you fix the frequency and 
calculate the possible propagation constants. In eigenfrequency analysis, it is the other 
way around. There is no azimuthal wave case because waves cannot travel around an 
axis.
A P P L I C A T I O N  M O D E  S U M M A R Y  |  7



8 |  C H A P T E R  1
Time-Dependent and Time-Harmonic Analysis

When variations in time are present there are two main approaches to represent the 
time dependence. The most straightforward is to solve the problem by calculating the 
changes in the solution for each time step. However, this approach can be time 
consuming if small time steps are necessary for the desired accuracy. It is necessary 
when your inputs are transients like turn-on and turn-off sequences.

An efficient simplification is to assume that all variations in time occur as sinusoidal 
signals. Then the problem is time-harmonic and you can formulate it as a stationary 
problem with complex-valued solutions. The complex value represents both the 
amplitude and the phase of the field, while the frequency is specified as a predefined 
scalar variable. This approach is useful because, combined with Fourier analysis, it 
applies to all periodic signals with the exception of nonlinear problems. Examples of 
typical harmonic simulations are wave-propagation problems like waveguides and 
antennas (see “Waveguide H-Bend with S-parameters” on page 80).

For nonlinear problems you can use a time-harmonic analysis after a linearization of 
the problem, which assumes that the distortion of the sinusoidal signal is small. See 
“Distributed SPICE Model of an Integrated Bipolar Transistor” on page 457 in the 
COMSOL Multiphysics Model Library.

You need to specify a time-dependent analysis when you think that the nonlinear 
influence is strong, or if you are interested in the harmonic distortion of a sine signal. 
It may also be more efficient to use a time-dependent analysis if you have a periodic 
input with many harmonics, like a square-shaped signal.

Application Modes

Each of the mode descriptions below has a reference to the page where you can find a 
more detailed description. You can also look at Table 4-1 on page 107, which provides 
a summary of all application modes with dependent variables and references to more 
detailed information.
:  I N T R O D U C T I O N



E L E C T R O M A G N E T I C  WAV E S

For wave problems in 3D, there are two application modes:

• Electromagnetic Waves

This application mode supports harmonic propagation (time-harmonic analysis), 
time-dependent analysis and eigenfrequency analysis. See “3D Electromagnetic 
Waves Application Mode” on page 112.

• Boundary Mode Analysis

The simulation is a 2D problem defined on a planar face in the 3D geometry. The 
mode analysis is the only available analysis type. See “Boundary Mode Analysis 
Application Mode in 3D” on page 148.

The 2D application modes were discussed in the section “Field Variables in 2D”. Only 
the references to the detailed descriptions for each application mode are given here.

• Perpendicular Waves

See “Perpendicular Waves Application Mode” on page 139.

• In-Plane Waves

See “In-Plane Waves Application Mode” on page 123 or “Axisymmetric Waves 
Application Mode” on page 132.

• Boundary Mode Analysis

The simulation is a 1D problem defined on a straight line in the 2D geometry. The 
mode analysis is the only available analysis type. See “Boundary Mode Analysis 
Application Mode in 2D” on page 151.
A P P L I C A T I O N  M O D E  S U M M A R Y  |  9
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 2
R F  M o d e l i n g
The goal of this section is to familiarize you with the modeling procedure in the 
RF Module. Because this module is totally integrated with COMSOL Multiphysics, 
the modeling process is similar. This chapter also shows a number of models 
illustrating different aspects of the simulation process. It steps you through all the 
stages of modeling, from geometry creation to postprocessing.
 11
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Mode l  De s c r i p t i o n s

Formats for the Model Descriptions

The way COMSOL Multiphysics orders its toolbar buttons and menus mirrors the 
basic procedural flow during a modeling session. You work your way from left to right 
in the process of modeling, defining, solving, and postprocessing a problem using the 
COMSOL Multiphysics graphical user interface (GUI). Thus, this manual as well as 
the accompanying RF Module Model Library manual and the COMSOL Multiphysics 
Model Library maintain a certain style convention when describing models. The 
format includes headlines that correspond to each major step in the modeling process; 
the headlines also roughly correspond to the various GUI modes and menus. 

M O D E L  N A V I G A T O R

The Model Navigator appears when you start COMSOL Multiphysics or when you 
restart completely within COMSOL Multiphysics by selecting New from the File menu 
or by clicking on the New toolbar button. On the New tab in the Model Navigator you 
specify the application mode, names of dependent variables, and the analysis type: 
static, time-harmonic, transient, mode analysis, or eigenfrequency. You can also set up 
a combination of application modes from the RF Module, COMSOL Multiphysics, or 
any other available module. See the section “Creating and Opening Models” on page 
22 in the COMSOL Multiphysics Quick Start for more information about the Model 
Navigator.

O P T I O N S  A N D  S E T T I N G S

This section reviews basic settings, for example, those for the axes and grid spacing. All 
settings are accessible from the Options menu, and some can be reached by 
double-clicking on the status bar. It is often convenient to use the Constants dialog box 
to enter constant parameters for the model or use the dialog boxes that you reach by 
pointing to Expressions to enter expression variables. Advanced models may also need 
coupling variables. COMSOL Multiphysics maintains libraries of materials accessible 
through the Materials/Coefficients Library dialog box.

G E O M E T R Y  M O D E L I N G

The process of setting up a model’s geometry requires knowledge of how to use the 
Draw menu and the Draw toolbar. For 2D the details appear in the section “Creating 
a 2D Geometry Model” on page 39 of the COMSOL Multiphysics User’s Guide. For 
3D you find them under “Creating a 3D Geometry Model” on page 56.
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B O U N D A R Y  C O N D I T I O N S

You specify the boundary conditions for a model in the Boundary Settings dialog box. 
For details, see “Specifying Boundary Conditions” on page 234 in the COMSOL 
Multiphysics User’s Guide. Valid boundary conditions for each electromagnetics 
mode are summarized in “The Application Mode Formulations” on page 106 of this 
manual. 

S U B D O M A I N  S E T T I N G

You specify equation parameters in the Subdomain Settings dialog box. For details see 
“Specifying Subdomain Settings and PDE Coefficients” on page 205 in the COMSOL 
Multiphysics User’s Guide. The physical parameters of specific interest for 
electromagnetics modeling are summarized in “The Application Mode Formulations” 
on page 106 of this manual, where you can also learn about the derivation of the 
equations as well as the boundary conditions.

S C A L A R  V A R I A B L E S

In the Application Scalar Variables dialog box you can examine and modify the values of 
predefined application-specific scalar variables, such as the frequency.

M E S H  G E N E R A T I O N

The program must mesh the geometry before it can solve the problem. Sometimes it 
is sufficient to click the Initialize Mesh button on the Main toolbar. In other cases you 
need to adjust settings in the Free Mesh Parameters dialog box and the other 
mesh-generation tools on the Mesh menu. Read more about meshing in “Creating 
Meshes” on page 286 of the COMSOL Multiphysics User’s Guide.

C O M P U T I N G  T H E  S O L U T I O N

To solve a problem, for most cases simply click the Solve button on the Main toolbar. 
In other cases it might be necessary to adjust the solver properties, which you do in 
the Solver Parameters dialog box. For details see “Selecting a Solver” on page 360 of 
the COMSOL Multiphysics User’s Guide.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The powerful visualization of COMSOL Multiphysics tools are accessible in the 
program’s Postprocessing mode, but to use them you must be familiar with the Plot 

Parameters dialog box and the other postprocessing tools on the Postprocessing menu. 
See “Postprocessing Results” on page 420 in the COMSOL Multiphysics User’s 
Guide  for details.
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A D D I T I O N A L  PO S T P R O C E S S I N G

For further postprocessing calculations, you can export the solution to COMSOL 
Script or MATLAB. Details of modeling by programming are available in “The 
Programming Language” on page 30 of this manual and in the COMSOL 
Multiphysics Scripting Guide.
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P r epa r i n g  f o r  Mode l i n g

This section is intended to guide you through the selection process among the 
application modes in the RF Module. Several topics in the art of modeling are covered 
here that you may not find in ordinary textbooks on electromagnetic theory. You will 
get help in answering questions like:

• Which spatial dimension should I use: 2D, 3D, or 2D axial symmetry?

• Is my problem suited for time-dependent or time-harmonic formulations?

• Can I use a quasi-static formulation, or do I need wave propagation?

• What sources can I use to excite the fields?

• When do I need to resolve the thickness of thin shells and when can I use boundary 
conditions?

The intention of this section is not to give detailed descriptions about each application 
mode but to give references to the information elsewhere in this manual. First you get 
a few general tips about modeling, helping you to decide what to include in your 
simulation. The next topic is related to the geometry, what you can do to minimize the 
size of your problem, and which spatial dimension (2D or 3D) that suits your model. 
This section also includes some tips about boundary conditions and how you can use 
these to minimize the geometry. Then the issues regarding the numerical part of your 
model are discussed, that is, meshing and solving. The final topics cover more specific 
issues about the application modes, the analysis types, and how to treat the fields and 
sources.

G E N E R A L  T I P S

Before you start modeling, try first to answer the following questions:

• What is the purpose of the model?

• What information do you want to extract from the model?

It is important to remember that a model never captures all the details of reality. 
Increasing the complexity of a model to make it more accurate usually makes it more 
expensive to simulate. A complex model is also more difficult to manage and interpret 
than a simple one. Keep in mind that it can be more accurate and efficient to use several 
simple models instead of a single, complex one.
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Simplifying Geometries

Most of the problems that you solve with COMSOL Multiphysics are 
three-dimensional (3D) in the real world. In many cases, it is sufficient to solve a 
two-dimensional (2D) problem that is close to or equivalent to your real problem. 
Furthermore, it is good practice to start a modeling project by building one or several 
2D models before going to a 3D model. This is because 2D models are easier to 
modify and solve much faster. Thus, modeling mistakes are much easier to find when 
working in 2D. Once you have verified your 2D model, you are in a much better 
position to build a 3D model.

2 D  P R O B L E M S

The text below guides you through some of the common approximations made for 2D 
problems. Remember that the modeling in 2D usually represents some 3D geometry 
under the assumption that nothing changes in the third dimension.

Cartesian Coordinates
In this case you view a cross section in the xy-plane of the actual 3D geometry. The 
geometry is mathematically extended to infinity in both directions along the z-axis, 
assuming no variation along that axis. All the total flows in and out of boundaries are 
per unit length along the z-axis. A simplified way of looking at this is to assume that 
the geometry is extruded one unit length from the cross section along the z-axis. The 
total flow out of each boundary is then from the face created by the extruded boundary 
(a boundary in 2D is a line).

There are usually two approaches that lead to a 2D cross-section view of a problem. 
The first approach is when you know there is no variation of the solution in one 
particular dimension. This is shown in the model “Waveguide H-Bend with 
S-parameters” on page 80 in the RF Module Model Library, where the E field only 
has one component in the z direction and is constant along that axis. The second 
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approach is when you have a problem where you can neglect the influence of the finite 
extension in the third dimension.

Figure 2-1: The cross sections and their real geometry for Cartesian coordinates and 
cylindrical coordinates (axial symmetry).

Axial Symmetry (Cylindrical Coordinates)
If you can construct the 3D geometry by revolving a cross section around an axis, and 
no variations in any variable occur when going around the axis of revolution, you can 
use an axisymmetric application mode. The spatial coordinates are called r and z, where 
r is the radius. The flow at the boundaries is given per unit length along the third 
dimension. Because this dimension is a revolution, you have to multiply all flows with 
αr, where α is the revolution angle (for example, 2π for a full turn). See the model 
“Monoconical RF Antenna” on page 45 in the RF Module Model Library for an 
example.

3 D  P R O B L E M S

Although COMSOL Multiphysics fully supports arbitrary 3D geometries, it is 
important to simplify the problem. This is because 3D problems easily get large and 
require more computer power, memory, and time to solve. The extra time you spend 
on simplifying your problem is probably well spent when solving it. Below are a few 
issues that you need to address before starting to implement a 3D model in the RF 
Module.

• Check if it is possible to solve the problem in 2D. Given that the necessary 
approximations are small, the solution will be more accurate in 2D, because you can 
use a much denser mesh. If you find this applicable, take a look at the section “2D 
Problems”.

• Look for symmetries in the geometry and model. Many problems have planes where 
the solution is the same on both sides of the plane. A good way to check this is to 
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flip the geometry around the plane, for example, by turning it up-side down around 
the horizontal plane. You can then remove the geometry below the plane if you do 
not see any differences between the two cases regarding geometry, materials, and 
sources. Boundaries created by the cross section between the geometry and this 
plane need a symmetry boundary condition, which is available in all 3D application 
modes.

• There are also cases when the dependence along one direction is known, so you can 
replace it by an analytical function. You can use this approach either to convert 3D 
to 2D or to convert a layer to a boundary condition (see also the section “Boundary 
Conditions” below).

B O U N D A R Y  C O N D I T I O N S

An important technique to minimize the problem size is to use efficient boundary 
conditions. Truncating the geometry without introducing too large errors is one of the 
great challenges in modeling. Below are a few suggestions of how to do this. They 
apply to both 2D and 3D problems.

• Many models extend to infinity or may have regions where the solution only 
undergoes small changes. This problem is addressed in two related steps. First, you 
need to truncate the geometry in a suitable position. Second, you need to apply a 
suitable boundary condition there. For static and quasi-static models, it is often 
possible to assume zero fields at the open boundary, provided that this is at a 
sufficient distance away from the sources. For radiation problems, you must apply 
special low-reflecting boundary conditions. This boundary should be in the order 
of a few wavelengths away from any source (see “Monoconical RF Antenna” on 
page 45 in the RF Module Model Library). A more accurate option is to use 
Perfectly Matched Layers, which is a layer that absorbs all radiated waves with small 
reflections (see “Dielectric Scattering PML” on page 8 in the RF Module Model 
Library). 

• Replace thin layers with boundary conditions where possible. There are several types 
of boundary conditions in COMSOL Multiphysics suitable for such replacements. 
You can, for example, replace materials with high conductivity by the perfect electric 
conductor (PEC) boundary condition.

• Use boundary conditions for known solutions. For example, an antenna aperture 
can be modeled as an equivalent surface current density on a 2D face (boundary) in 
a 3D model.
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S O U R C E S

You can apply electromagnetic sources in many different ways. The typical options are 
boundary sources, line sources, and point sources, where point sources in 2D 
formulations are equivalent to line sources in 3D formulations. The way sources are 
imposed can have an impact on what quantities you can compute from the model. For 
example, a line source in an electromagnetic wave model represents a singularity and 
the magnetic field does not have a finite value at the position of the source. In a 
COMSOL Multiphysics model, a line source has a finite but mesh-dependent value. In 
general, using volume or boundary sources is more flexible than using line sources or 
point sources, but the meshing of the source domains becomes more expensive.

Meshing and Solving

The finite element method approximates the solution within each element, using some 
elementary shape function that can be constant, linear, or of higher order. Depending 
on the element order in the model, a finer or coarser mesh is required to resolve the 
solution. In general, there are three problem-dependent factors that determine the 
necessary mesh resolution:

• The first is the variation in the solution due to geometrical factors. The mesh 
generator automatically generates a finer mesh where there is a lot of fine 
geometrical details. Try to remove such details if they do not influence the solution, 
because they produce a lot of unnecessary mesh elements.

• The second is the skin effect or the field variation due to losses. It is easy to estimate 
the skin depth from the conductivity, permeability, and frequency. You need at least 
two linear elements per skin depth to capture the variation of the fields. If you do 
not study the skin depth, you can replace regions with a small skin depth with a 
boundary condition, thereby saving elements. If you find it necessary to resolve the 
skin-depth, the boundary layer meshing technique can be a convenient way to get a 
dense mesh near a boundary (“Creating Boundary Layer Meshes Interactively” on 
page 341 in the COMSOL Multiphysics User’s Guide).

• The third and last factor is the wavelength. To resolve a wave properly, it is necessary 
to use about 10 linear (or 5 2nd order) elements per wavelength. Keep in mind that 
the wavelength may be shorter in a dielectric medium.

S O L V E R S

You can, in most cases, use the solver that COMSOL Multiphysics suggests. The 
choice of solver is optimized for the typical case for each application mode and analysis 
type in the RF Module. However, in special cases you might need to tune the solver 
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settings. This is especially important for 3D problems because they use a large amount 
of memory. For extremely large 3D problems, you might need a 64-bit platform. You 
can find a more detailed description on the solver settings in “Solving the Model” on 
page 359 in the COMSOL Multiphysics User’s Guide. See also “Solving Large 3D 
Problems” on page 69.

Hermitian Transpose
The Use Hermitian transpose of constraint matrix and in symmetry detection setting on 
the Advanced tab controls the handling of complex numbers in constraints to the 
equations. One case in the RF Module when complex numbers appear in a constraint 
is when using a periodic boundary condition that includes a complex phase factor, a 
so-called Floquet periodicity. In this case, select the Use Hermitian transpose of 

constraint matrix and in symmetry detection check box.
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An Examp l e—Wavegu i d e  H -B end

Introduction

This examples shows how to model a rectangular waveguide for microwaves. A single 
hollow waveguide can conduct two kinds of electromagnetic waves: transversal 
magnetic (TM) or transversal electric (TE) waves. This model examines a TE wave, 
one that has no electric field component in the direction of propagation. More 
specifically, for this model you select the frequency and waveguide dimension so that 
TE10 is the single propagating mode. In that mode the electric field has only one 
nonzero component—a sinusoidal with two nodes, one at each of the walls of the 
waveguide.

One important design aspect is how to shape a waveguide to go around a corner 
without incurring unnecessary losses in signal power. Unlike in wires, these losses 
usually do not result from ohmic resistance but instead arise from unwanted 
reflections. You can minimize these reflections by keeping the bend smooth with a 
large enough radius. In the range of operation the transmission characteristics (the 
ability of the waveguide to transmit the signal) must be reasonably uniform for 
avoiding signal distortions.

Model Definition

This example illustrates how to create a model that computes the electromagnetic 
fields and transmission characteristics of a 90° bend for a given radius. This type of 
waveguide bends changes the direction of the H field components and leaves the 
direction of the E field unchanged. The waveguide is therefore called an H-bend. The 
H-bend design used in this example is well-proven in real-world applications and you 
can buy similar waveguide bends online from a number of manufacturers. This 
particular bend performs optimally in the ideal case of perfectly conducting walls as is 
shown later on in this model by computing the (in this case optimal) transmission 
characteristics.

The waveguide walls are typically plated with a very good conductor, such as silver. In 
this example the walls are considered to be made of a perfect conductor, implying that 
n × E = 0 on the boundaries. This boundary condition is referred to as a perfect 
electric conductor (PEC) boundary condition.
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The geometry is as follows, as viewed in the xy-plane.

D O M A I N  E Q U A T I O N S

The waveguide is considered to continue indefinitely before and after the bend. This 
means that the input wave needs to have the form of a wave that has been traveling 
through a straight waveguide. The shape of such a wave is determined by the boundary 
conditions of Maxwell’s equations on the sides of the metallic boundaries, that is, the 
PEC boundary condition. If polarized according to a TE10 mode, the shape is known 
analytically to be E = (0, 0, sin(π (a − y) / (2 a))) cos(ωt) given that the entrance 
boundary is centered around the y = 0 axis, and that the width of the waveguide, in 
the y direction, is 2a.

In the RF Module you can model this waveguide in the 2D In-Plane TE Waves 
application mode or in the 3D Electromagnetic Waves application mode as a 
time-harmonic wave propagation model. This means that only the phasor component 
of the field is modeled. The incident field then has the form 
E = (0, 0, E0z) = (0, 0, sin(π (a − y) / (2 a))), and is considered as part of the expression 
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, where complex-valued 
arithmetic has been used (also referred to as the jω method).

The width of the waveguide is chosen so that it has a cutoff frequency of 4.3 GHz. 
This makes the waveguide operational between 5.4 GHz up to 8.1 GHz. At higher 
frequencies other modes than the TE10 appear, causing a “dirty” signal. The input 
wave then splits into several modes that are hard to control without having large power 
losses. Below the cutoff frequency, no waves can propagate through the waveguide. 
This is an intrinsic property of microwave waveguides.

The cutoff frequency of different modes in a straight waveguide is given by the relation

where m and n are the mode numbers (m = 1, n = 0 for the TE10 mode), a and b are 
the lengths of the sides of the waveguide cross-section, and c is the speed of light.

For this waveguide, a = 2b and b = 0.0174245.

The first few cutoff frequencies are (νc)10 = 4.3 GHz, (νc)01 = 8.6 GHz, 
(νc)11 = 9.6 GHz and the operational range is chosen to be 1.25(νc)10 = 5.4 GHz to 
0.95(νc)10 = 8.1 GHz. This is to have reasonable margins for manufacturing errors 
and to avoid the large reflections that occur at lower frequencies.
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B O U N D A R Y  C O N D I T I O N S

This model makes use of the predefined port boundary condition. It is an automated 
version of the matched boundary condition described later in this section. An 
additional advantage is that the port boundary condition automatically creates 
postprocessing variables for the S-parameters. 

The input matched boundary condition consists of two parts: an incident planar wave 
and an absorbing boundary condition. The matched boundary condition is also used 
at the output boundaries to eliminate any reflections there. At the output boundaries 
there is no excitation. The walls of the waveguide are considered to be good 
conductors, so you can use the perfectly electric conductive (PEC) boundary 
condition.

For specifying the absorbing boundary condition you must know the propagation 
constant, β, of the wave. You can find the propagation constant from an eigenmode 
analysis of the waveguide cross section.

In this simple case, however, you can also compute the propagation constant by hand 
using the relation

for the wavenumbers in the x,  y, and z directions, respectively, at the waveguide 
entrance port. Here x is the direction of propagation, and y and z are the transversal 
directions, with z as the out-of-plane direction. In an infinitely extended straight 
waveguide, the following equations define the free-space and the x, y, and z direction 
wavelengths:

In this case, the y direction wavelength is known to be 2a because the model describes 
the lowest propagating mode, which is a half wavelength across the transversal 
direction. This means for the wave number in the y direction
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Also, for the TE10 mode, 

The free-space wave number is

The propagation constant evaluates to

,

which is a frequency-dependent expression.

Now, for the matched boundary condition, entering the correct propagation constant 
eliminates all waves with that wavenumber in the propagating direction. To make the 
boundary condition perfectly absorbing, the propagating direction needs to be the 
same as the normal direction of the output boundary.

Note: The input amplitude can be replaced by any analytical expression. You can, for 
instance, create a wave corresponding to a truncated Gaussian beam or simply a 
planar wave, for which the expression would be 1.

The first part of the analysis is made for a frequency that is 20% above the cutoff 
frequency. This is to show a generic propagating wave within the frequency range of 
operation.
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Results and Discussion

The wave is found to propagate through the bend with very small reflection.

To verify that there is almost no reflection you can compare the power flow of the 
outgoing wave to that of the incoming wave. The entrance port is excited using the 
port boundary condition, which automatically normalizes the excitation to unit power 
(1 W). Comparing this to the power flow over the output port, 1.006 W, shows that 
the power loss is less than 1%.

For the 2D version of the model the power flow is 0.99993 W, indicating that any 
reflected power is too small to be detected. The 2D model is more accurate than the 
3D model because it uses a finer mesh that better resolves the waves.

Model Library path: RF_Module/RF_and_Microwave_Engineering/hbend_3d
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3D Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 In the Model Navigator, select 3D in the Space dimension list.

2 In the list of application modes, select RF Module>Electromagnetic Waves>Harmonic 

propagation.

3 Click OK.

O P T I O N S  A N D  S E T T I N G S

Define the following constants in the Constants dialog box (the descriptions are 
optional).

G E O M E T R Y  M O D E L I N G

1 From the Draw menu, open the Work-Plane Settings dialog box. Click OK to obtain 
the default work plane in the xy-plane.

2 From the Options menu, choose Axes/Grid Settings.

NAME EXPRESSION DESCRIPTION

fc 4.3e9 Cutoff frequency

fq1 1.2*fc 20% above cutoff
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3 In the Axes/Grid Settings dialog box, specify the following axis and grid settings, and 
then click OK:

To define the grid spacings, first click the Grid tab and clear the Auto check box.

The waveguide width 2*0.0174245 corresponds to a cutoff frequency of 4.3 GHz.

4 Start by drawing three lines. After selecting the Line button on the Draw toolbar, 
click at (0, −0.0174), (−0.1, −0.0174), (−0.1, +0.0174), and (0, +0.0174).

5 Click the 2nd Degree Bézier Curve button, and click at (0.0576, 0.0174) and 
(0.0576, 0.075). 

6 Click the Line button, and click at (0.0576, 0.175), (0.0924, 0.175), and 
(0.0924, 0.075). 

7 Click the 2nd Degree Bézier Curve button, and click at (0.0924, −0.0174). 

8 Finish by clicking the right mouse button to close the boundary curve and create a 
solid object.

AXIS GRID

x min -0.175 x spacing 0.05

x max 0.175 Extra x 0.075-0.0174245 0.075+0.0174245

y min -0.04 y spacing 0.05

y max 0.2 Extra y -0.0174245 0.0174245 0.075 0.175
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9 Select Extrude from the Draw menu. Extrude the object using a distance of 0.0174.

10 Click the Zoom Extents button on the Main toolbar.

P H Y S I C S  S E T T I N G S

Scalar Variables
1 From the Physics menu, choose Scalar Variables.

2 In the Application Scalar Variables dialog box, set the frequency nu_rfw to fq1, and 
then click OK.

Boundary Conditions
1 From the Physics menu, choose Boundary Settings.

2 Select Boundaries 2–8 and 10.

3 In the Boundary condition list, select Perfect electric conductor as the boundary 
condition. These boundaries represent the inside of the walls of the waveguide 
which is plated with a metal, such as silver, and considered to be a perfect conductor.
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4 On Boundaries 1 and 9, specify the Port boundary condition. On the Port page, set 
the values according to the following table; when done, click OK.

Subdomain Settings
Use the default values for εr, µr, and σ, because the waveguide is filled with air.

M E S H  G E N E R A T I O N

1 In the Free Mesh Parameters dialog box, click the Custom mesh size button, and then 
type 0.006 in the Maximum element size edit field.

SETTINGS BOUNDARY 1 BOUNDARY 9

Port number 1 2

Wave excitation at this port Selected Cleared

Mode specification Rectangular Rectangular

Mode type Transverse electric (TE) Transverse electric (TE)

Mode number 10 10
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2 Click Remesh to generate the mesh; then click OK.

C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button on the Main toolbar to solve the problem.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The default plot is a slice plot of the total energy density. This is a convenient way to 
visualize the good transmission, because reflections give rise to a wave pattern in the 
energy distribution. To better see the propagating wave change the position of the 
slices.

1 From the Postprocessing menu, choose Plot Parameters.

2 On the Slice tab in the Plot Parameters dialog box set the Slice positioning x levels to 
0, the y levels to 0, and the z levels to 1.
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3 Click Apply to see the following plot.

4 To better see the propagating wave, plot the z-component of the electric field. Select 
Electric field, z-component from the Predefined quantities list.
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5 Choose the wave colormap and click OK.

6 To compare the power flow of the incident wave to the power flow of the outgoing 
wave, perform a boundary integration. The entrance port is excited using the port 
boundary condition, which provides an excitation with a power level of 1 W. To 
obtain the power outflow from the exit port, open the Boundary Integration dialog 
box from the Postprocessing menu, and integrate Power outflow, time average over 
Boundary 9. The result is about 1.006 W and appears in the message log at the 
bottom of the main window.

Model Library path: RF_Module/RF_and_Microwave_Engineering/hbend_2d

2D Modeling Using the Graphical User Interface

The results obtained in the 3D calculation are independent of the height b of the 
waveguide as the TE10 wave does not vary in the z direction. This means that the 
model can just as well be made in 2D.
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You find an extended version of this model with an S-parameter study in the section 
“Waveguide H-Bend with S-parameters” on page 80 in the RF Module Model 
Library. See also the section “S-Parameters and Ports” on page 56 for more 
information about S-parameter calculations.

M O D E L  N A V I G A T O R

1 Select 2D from the Space dimension list.

2 Select the RF Module>In-Plane Waves>TE Waves>Harmonic propagation application 
mode.

3 Click OK.

O P T I O N S  A N D  S E T T I N G S

Define the same constants as in the 3D model on page 27.

G E O M E T R Y  M O D E L I N G

Use the same axes/grid settings and draw the same geometry as in the 2D work plane 
in the 3D model.

P H Y S I C S  S E T T I N G S

Scalar Variables
1 From the Physics menu, choose Scalar Variables.

2 In the Application Scalar Variables dialog box, set the frequency nu_rfwe to fq1, and 
then click OK.

Boundary Conditions
Use the same boundary conditions as in the 3D model:

1 On Boundaries 2–4 and 6–8, select the Perfect electric conductor boundary 
condition.

2 On Boundaries 1 and 5, specify the Port boundary condition. On the Port tab set 
the values according to the table below:

SETTINGS BOUNDARY 1 BOUNDARY 5

Port number 1 2

Wave excitation at this port Selected Cleared

Mode specification Analytic Analytic

Mode number 1 1
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M E S H  G E N E R A T I O N

1 Initialize the mesh.

2 Refine the mesh twice.

C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button on the Main toolbar.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The default plot shows the z component of the electric field. Qualitatively, the result 
coincides with the result in the 3D model. The difference in amplitude is because the 
input power in the 2D port boundary condition is 1 W per unit depth (1m).

1 To plot the energy density, open the Plot Parameters dialog box.
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2 Click the Surface tab, and select Total energy density, time average from the 
Predefined quantities list in the Surface data area. Click OK.

This again shows that the reflections are very small. To further verify this compare the 
power flow of the incoming wave to the outgoing wave. To compare the power flow 
of the incident wave to the power flow of the outgoing wave, perform a boundary 
integration. The entrance port is excited using the port boundary condition, which 
provides an excitation with a power level of 1 W (per unit depth). To obtain the power 
outflow from the exit port, open the Boundary Integration dialog box from the 
Postprocessing menu, and integrate Power outflow, time average over Boundary 5. The 
result, 0.99993 W, which appears in the message log, indicates that any reflected 
power is too small to be detected. Note that the 2D model is more accurate than the 
3D model because it uses a finer mesh that better resolves the waves.
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Pe r i o d i c  Bounda r y  Cond i t i o n s

The section “Using Periodic Boundary Conditions” on page 245 in the COMSOL 
Multiphysics User’s Guide presents a general description on how to define general 
periodic boundary conditions. The RF Module has an automatic Periodic condition 
accessible from the Boundary Settings dialog box, so it is not necessary to use the 
Periodic Boundary Conditions dialog box. Use the latter dialog box for special cases 
when you need full control of the periodic condition. The automatic periodic 
condition can identify simple mappings on plane source and destination boundaries of 
equal shape. The destination can also be rotated with respect to the source. There are 
three types of periodic conditions available (only the first two for transient analysis):

• Continuity—The tangential components of the solution variables are equal on the 
source and destination.

• Antiperiodicity—The tangential components have opposite signs.

• Floquet periodicity—There is a phase shift between the tangential components. The 
phase shift is determined by a wave vector and the distance between the source and 
destination.

The 3D Electromagnetic Waves application modes and some transient in-plane 
application modes use vector elements for the electric and magnetic fields. In these 
application modes, there is a variable Ψ that implements an extra equation to explicitly 
set the divergence of the D or B field to zero. Similar to using assemblies with vector 
elements, periodic conditions must use this extra equation when the source and 
destination of the periodic condition have incompatible meshes; see “Using 
Assemblies in Electromagnetic Problems” on page 84 for more details. This variable Ψ 
must also be made periodic, something the automatic periodic condition takes care of 
if the divergence condition is active. The following example model uses the copy mesh 
feature to ensure that the mesh on the destination boundary is identical to that on the 
source boundary. As a result, no extra divergence condition is required.

Model Definition

This example model describes how to define periodic boundary conditions in the 3D 
Electromagnetic Waves application mode. Consider the cube in Figure 2-2. In this 
model you set the electric field on the two boundaries parallel to the yz-plane equal, 
and then solve an eigenfrequency problem with this constraint.
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Figure 2-2: The cubic model geometry.
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Results and Discussion

The cube has three degenerated eigenfrequencies: 150 MHz, 212 MHz, and 
300 MHz. The plot in Figure 2-3 shows the z component of the electric field for a 
300 MHz mode.

Figure 2-3: The electric field’s  z component.

Model Library path:  

RF_Module/Tutorial_Models/periodic_boundary_condition

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R  A N D  A P P L I C A T I O N  M O D E  P R O P E R T I E S

1 In the Model Navigator select 3D from the Space dimension list. Open the RF Module 
folder, then select Electromagnetic Waves>Eigenfrequency analysis. 

2 Click OK.
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G E O M E T R Y  M O D E L I N G

1 Use the Block tool to make a cube with sides of length 1.

2 Click the Zoom Extents button on the Main toolbar.

P H Y S I C S  S E T T I N G S

Boundary Conditions
1 You specify the periodic condition in the Physics>Boundary Settings dialog box. 

Select the boundaries that define one periodic condition. These consist of one or 
more source boundaries plus one or more destination boundaries. The combined 
cross section of all source boundaries must be equal in shape to the combined cross 
section of all destination boundaries. If you want several periodic conditions with 
different orientations, separate them with a group index entered in the Group index 
edit field.

2 Select Boundaries 1 and 6, and choose Periodic condition from the Boundary 

condition list. Leave the Type of periodicity list at its default value, Continuity. The 
boundary with the lowest number becomes the source by default. It is possible to 
change this order by selecting the Change source and destination order check box.

M E S H  G E N E R A T I O N

1 Open the Free Mesh Parameter dialog box and select Coarse from the Predefined mesh 

sizes list.

2 On the Boundary tab, select Boundary 1 and click the Mesh Selected button.
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3 Click OK to close the dialog box.

4 Choose Mesh > Copy Boundary Mesh Parameters.

5 Select the check box for Boundary 1 in the Source boundaries list.

6 Select the check box for Boundary 6 in the Target boundaries list.

7 Click the Copy Mesh button, then OK.

8 Click the Mesh Remaining (free) button on the Mesh toolbar.

C O M P U T I N G  T H E  S O L U T I O N

1 Choose Solve>Solver Parameters.

2 In the Solver Parameters dialog box, enter 250e6 in the Search for eigenfrequencies 

around edit field.

3 Click OK, then Solve.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

1 Open the Plot Parameters dialog box.

2 Click the Slice tab.

3 Select Electric field, norm from the Predefined quantities list.

4 Set the Number of levels in the x and z directions to 1.

5 On the Arrow tab, select the Arrow plot check box and click OK.

6 Click the Scene Light button.

This will get you an arrow plot of the electric field and a slice plot of its norm, for the 
lowest eigenfrequency. You can browse between the solutions on the General page of 
the Plot Parameters dialog box. One of the 300 MHz eigenfrequencies will get you a 
plot resembling Figure 2-3.
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Note: If the periodic boundary condition includes a complex phase factor you must 
select the Use Hermitian transpose of constraint matrix and in symmetry detection check 
box on the Advanced tab in the Solver Parameters dialog box. This is the case for a 
periodic condition of type Floquet periodicity with a nonzero k-vector.
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Pe r f e c t l y  Ma t c h ed L a y e r s  ( PML s )

One of the challenges in finite element modeling is how to treat open boundaries in 
radiation problems. The RF Module offers two closely related types of absorbing 
boundary conditions, the scattering boundary condition and the matched boundary 
condition. The former is perfectly absorbing for a plane wave, whereas the latter is 
perfectly absorbing for guided modes, provided that the correct value of the 
propagation constant is supplied. However, in many scattering and antenna-modeling 
problems, you cannot describe the incident radiation as a plane wave with a 
well-known direction of propagation. In such situations, consider using perfectly 
matched layers (PMLs). A PML is strictly speaking not a boundary condition but an 
additional domain that absorbs the incident radiation without producing reflections. 
It provides good performance for a wide range of incidence angles and is not 
particularly sensitive to the shape of the wave fronts. The PML formulation can be 
deduced from Maxwell’s equations by introducing a complex-valued coordinate 
transformation under the additional requirement that the wave impedance should 
remain unaffected as in Ref. 1. The following section describes how to use the 
semiautomatic PMLs in the RF Module to create planar, cylindrical, and spherical 
PMLs.

PML Implementation

This RF Module uses the following coordinate transform for the general coordinate 
variable t.

 (2-1)

The coordinate, t, and the width of the infinite element region, δt, are input 
parameters for each region. These parameters get a default setting according to the 
drawn geometry, but it does not work for complex configurations. Typical examples of 
PML regions that work nicely are shown in the following figures for each of the PML 
types. These types are:

• Cartesian—PMLs absorbing in Cartesian coordinate directions.

• Cylindrical—PMLs absorbing in cylindrical coordinate directions from a specified 
axis. For axisymmetric geometries the cylinder axis is the z-axis.

t' t λ
δt
----- 1 i–( )=
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• Spherical—PMLs absorbing in the radial direction from a specified center point.

For each of the above PML types, you can choose the coordinate directions in which 
the PML should absorb waves, that is, for which directions a coordinate 
transformation of the type Equation 2-1 should apply. To allow complete flexibility 
in defining a PML there is, in addition, a fourth option:

• User defined—General PMLs or domain scaling with user-defined coordinate 
transformations.

Figure 2-4: A cube surrounded by typical PML regions of the type “Cartesian.”
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Figure 2-5: A cylinder surrounded by typical cylindrical PML regions.

Figure 2-6: A sphere surrounded by a typical spherical PML region.

If you use other shapes for the PML regions not similar to the shapes shown in the 
previous figures, it might be necessary to define the PML parameters manually. The 
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software store the default parameters in variables with the naming convention 
<param>_guess_<suffix>, where <param> is the name of the parameter and 
<suffix> is the application mode suffix.

When the width is equal to the actual PML region width in the geometry, the 
coordinate scaling alters the wavelength so that it is equal to the PML region width. 
Especially for small geometries, where the size of the geometry is smaller than the 
wavelength, it might be better to keep the wavelength unchanged in the PML region. 
Enter lambdaS_<suffix> as PML region width to get this effect. The damping is not 
as good, but it can still be enough to avoid reflections. An absorbing boundary 
condition outside the PML region often reduce the reflections further; for example, it 
is often efficient to use the scattering boundary condition for spherical waves together 
with a spherical PML region.
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You can check the values of the default guess variables for the PML parameters in 
Equation System>Subdomain Settings under the Physics menu. Click the Variables tab 
and look for variables with _guess_ in the name.

Reference

1. Jianming Jin, The Finite Element Method in Electromagnetics, 2nd Edition, 
Wiley-IEEE Press, May 2002.

Example Models

For examples on using perfectly matched layers, use any of the following models in the 
the RF Module Model Library.

• “Dielectric Scattering PML” on page 8 (2D cartesian PML).

• “Absorbed Radiation (SAR) in the Human Brain” on page 110 (3D cartesian 
PML).

• “Balanced Patch Antenna for 6 GHz” on page 136 (spherical PML).

The model “Dielectric Scattering PML” is a 2D tutorial model, so it is recommended 
to start with that one.
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S c a t t e r e d - F i e l d  F o rmu l a t i o n

For many problems, it is the scattered field that is the interesting quantity. Such models 
usually have a known incident field that you really do not need to compute the solution 
for, so there are several benefits to reduce the formulation and only solve for the 
scattered field. If the incident field is much larger in magnitude than the scattered field, 
the accuracy of the simulation improves if you solve for the scattered field. 
Furthermore, the excitation of the plane wave is easier to set up, because for 
scattered-field problems you specify it as a global plane wave. Otherwise you have to 
set up matched boundary conditions around your structure, which can be rather 
complicated for nonplanar boundaries. Especially when using perfectly matched layers 
(PMLs), the advantage of using the scattered-field formulation becomes clear. With a 
full-wave formulation, you have to take the damping in the PML into account when 
exciting the plane wave, because the excitation appears outside the PML. With the 
scattered-field formulation you specify the plane wave for all non-PML regions, so it is 
not at all affected by the PML design.

Application Modes with Scattered Fields

The scattered-field formulation is available for the 3D Electromagnetic Waves, 
In-Plane Waves, and Meridional Waves application modes. It is accessible as the 
analysis type Scattered harmonic propagation that you choose directly in the Model 

Navigator under one of the abovementioned application modes. Alternatively, you can 
choose it from the Field type list in the Application Mode Properties dialog box. You 
open this dialog box by choosing Physics>Properties.

The scattered field is always available as a variable with the letters sc in front of the 
field name, for example, scE for the scattered electric field. If you solve for the total 
field, this variable is the total field subtracted with the incident field. Similarly, the total 
electric field is always available, and for the scattered-field formulation this is the sum 
of the scattered field and the incident field. You specify the incident field in the 
Application Scalar Variables dialog box, which you open by choosing Physics>Scalar 

Variables.

Example Model—Dielectric Scattering PML

For an example on the scattered-field formulation, see the example model for PMLs in 
the section “Dielectric Scattering PML” on page 8 in the RF Module Model Library.
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F a r - F i e l d  Po s t p r o c e s s i n g

The far electromagnetic field from, for example, antennas can be calculated from the 
calculated near field on a boundary using far-field postprocessing. The antenna is 
located in the vicinity of the origin, while the far-field is taken at infinity but with a 
well-defined angular direction . The far-field radiation pattern is given by 
evaluating the squared norm of the far-field on a sphere centered at the origin. Each 
coordinate on the surface of the sphere represents an angular direction.

For the theory behind the far-field postprocessing, see “Far-Field Calculations” on 
page 99.

Far-Field Support in the Application Modes

The 3D Electromagnetic Waves, the Axisymmetric Waves, and the In-Plane Waves 
application modes support far-field postprocessing. To define the far-field variables use 
the Boundary Settings dialog box. On the Far-Field tab, select the boundaries where the 
algorithm then integrates the near field, and enter a name for the far electric field. 
Make sure the tangential electric field and the tangential curl of the electric field appear 
in the next two columns. The tabular structure of the dialog box makes it possible to 
define multiple far-field variables and change the fields used in the integral.

θ ϕ,( )
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In this dialog box, you can also specify if you want to use symmetry planes in your 
model when calculating the far-field variable. The symmetry planes have to coincide 
with one of the Cartesian coordinate planes (the check boxes x=0, y=0, and z=0). For 
each of these planes it is possible to select the type of symmetry you use, which can be 
of either Symmetric E field (PMC) or Symmetric H field (PEC). Make the choice here match 
the boundary condition you used for the symmetry boundary. Using these settings, 
you can include the parts of the geometry that are not in the model for symmetry 
reasons in the far-field analysis.

For each variable name that you enter, the software generates functions and variables, 
which represent the vector components of the far electric field. The names of these 
variables are constructed by appending the names of the independent variables to the 
name that you enter in the dialog box. For example, if you enter the name Efar and 
the geometry is Cartesian with the independent variables x, y, and z, the generated 
variables get the names Efarx, Efary, and Efarz. If, on the other hand, the geometry 
is axisymmetric with the independent variables r, phi, and z, the generated variables 
get the names Efarr, Efarphi, and Efarz. In 2D, the software only generates the 
variables in the direction where the electric field is nonzero. For example, in the 
In-Plane TE Waves application mode only the z component of the far field is available.

To each of the generated variables, there is a corresponding function with the same 
name. This function takes the vector components of the evaluated far-field direction as 
arguments. Note that the vector components also can be interpreted as a position. For 
example, assume that the variables dx, dy, and dz represent the direction in which you 
want to evaluate the far electric field. The expression

Efarx(dx,dy,dz)

gives the value of the far electric field in this direction. If you instead want to give the 
direction as an angle, use the expression

Efarx(sin(theta)*cos(phi),sin(theta)*sin(phi),cos(theta))

where you define the variables theta and phi to represent the angular direction 
. The magnitude of the far field and its value in dB are also generated as the 

variables normEfar and normEfardB, respectively.

Example Model—Far-Field Pattern from a Dipole Antenna

To illustrate far-field postprocessing, this example shows how to calculate the far-field 
pattern from a simple dipole antenna. The antenna is a current loop with the radius 
0.2 m and the frequency 1 GHz. Figure 2-7 shows the resulting near-field radiation 

θ ϕ,( )
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pattern at a distance 0.4 m from the center of the loop together with the far-field 
radiation pattern.

For another example of far-field postprocessing, see the model “Monoconical RF 
Antenna” on page 45 in the RF Module Model Library.

Figure 2-7: The near-field radiation pattern from the dipole (left), and the far-field 
radiation pattern (right).

Model Library path: RF_Module/Tutorial_Models/far_field

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 In the Model Navigator select Axial symmetry (2D) from the Space dimension list.

2 Open the RF Module folder, then select Electromagnetic Waves>TE Waves. 

3 Click OK.

G E O M E T R Y  M O D E L I N G

1 Select the Ellipse/Circle (Centered) tool and draw a circle centered at the origin with 
the radius 0.4 using the right mouse button.

2 Select the Rectangle/Square tool and draw a rectangle with corners at (−0.4, −0.4) 
and (0, 0.4).

3 Select both the rectangle and the circle and click the Difference button. This 
subtracts the rectangle from the circle.
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4 Finally add a point at (0.2, 0).

P H Y S I C S  S E T T I N G S

Boundary Conditions
1 The vertical boundary at r = 0 (boundary 1) represents the symmetry axis. 

Therefore select the Axial symmetry boundary condition at this boundary in the 
Boundary Settings dialog box.

2 The other two boundaries represent an open boundary where there should be no 
reflections. To achieve as small reflections as possible, select the Scattering boundary 

condition at these boundaries.

Point Settings
The point at (0.2, 0) (Point 3) represents a circular loop with a current. To specify this 
current set I0 to 1 at this point in the Point Settings dialog box.

M E S H  G E N E R A T I O N

1 Click the Initialize Mesh button on the Main toolbar.

2 Click the Refine Mesh button on the Main toolbar to refine the mesh.

C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button on the Main toolbar.
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PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The plot of the solution shows the electric field emitted from the circular loop.

Far-Field Postprocessing
To calculate the far field first define a variable for the far electric field.

1 Open the Boundary Settings dialog box from the Physics menu.

Eϕ
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2 On the Far-Field page select Boundaries 2 and 3 and enter the variable name Efar. 
The tangential electric field and the tangential curl of the electric field then appear 
in the other two columns.

3 The far-field variables are not immediately available. They first have to be evaluated 
using the previously calculated solution. To do this, choose Update Model from the 
Solve menu.

The definition of the variable Efar generates a function, Efarphi(r,z), which is the 
 component of the far electric field in the point (r, z). It also generates a variable, 

Efarphi, which is equal to the function value in every point. Because the near electric 
field only has a component, so does the far field. The radiation pattern is 
proportional to |Efar|

2, which you can access with the expression normEfar^2 and its 
dB value with normEfardB. To visualize the radiation pattern follow these steps:

1 Open the Domain Plot Parameters dialog box from the Postprocessing menu.

2 On the Line/Extrusion page, select Boundaries 2 and 3. 

3 In the y-axis data area, enter the Expression normEfardB.

4 In the x-axis data area, click the low option button, then click the Expression button.

5 In the X-Axis Data dialog box, enter the Expression atan2(r,z)[1/deg] to display 
the polar angle in degrees on the horizontal axis. Click OK to close the dialog box.

ϕ

ϕ
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6 Click Apply to plot the far-field radiation pattern on a dB scale.
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S - P a r ame t e r s  and Po r t s

S-Parameters in Terms of Electric field

Scattering parameters or S-parameters are complex-valued, frequency dependent 
matrices describing the transmission and reflection of electromagnetic energy 
measured at different ports of devices like filters, antennas, waveguide transitions, and 
transmission lines. S-parameters originate from transmission-line theory and are 
defined in terms of transmitted and reflected voltage waves. All ports are assumed to 
be connected to matched loads, that is, there is no reflection directly at a port.

For a device with n ports, the S-parameters are

where S11 is the voltage reflection coefficient at port 1, S21 is the voltage transmission 
coefficient from port 1 to port 2, and so on. The time average power reflection/
transmission coefficients are obtained as |Sij|

2.

Now, for high-frequency problems, voltage is not a well-defined entity, and it is 
necessary to define the scattering parameters in terms of the electric field. For details 
on how COMSOL Multiphysics calculates the S-parameters, see “S-Parameter 
Calculations” on page 95.

S-Parameter Calculations in COMSOL Multiphysics

The In-Plane Waves, Axisymmetric Waves, and the 3D Electromagnetic Waves 
application modes have built-in support for S-parameter calculations. To set up an 
S-parameter study use the port boundary condition for each port in the model. Specify 
the eigenmode of interest at each port. This is done on the Port tab in the Boundary 

Settings dialog box. A port boundary condition results in no reflections for the 
particular mode and gives you access to the S-parameters.

S

S11 S12 . . S1n

S21 S22 . . .

. . . . .

. . . . .
Sn1 . . . Snn

=
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T H E  C O E F F I C I E N T  T A B

Under the coefficient tab you set a boundary as a port when you select Port from the 
Boundary condition list. This activates controls for specifying port number, port as 
input, and port power level and phase.

Each port must have a unique port number. One of the ports should be an inport with 
an incident field. To specify the inport, select the Wave excitation at this port check box 
for that port. 

Note: It is only possible to excite one port at a time if the purpose is to compute 
S-parameters. If you excite several ports, the S-parameter calculation is turned off, 
and you can only use the ports to excite waves. The script sparametermatrix.m, 
available in COMSOL Script and MATLAB allows you to cycle through the ports and 
compute the entire S-matrix. In other cases, for example, when studying microwave 
heating, more than one inport might be wanted, but then the S-parameter variables 
cannot be correctly computed.

To adjust the power level of the inport, use the Power level edit field next to the check 
box. It is also possible to enter a phase shift for the input signal in the Port phase edit 
field. The port phase is intended to use when several ports are used as inports because 
it does not affect the S-parameter calculation.

T H E  P O R T  T A B

The Port tab gets enabled when you select a port boundary condition. This tab has 
controls for specifying the mode of the port. You can specify three different types of 
port modes:

• Modes for ports of certain shapes: rectangular, circular, and coaxial. They all apply 
to port of a homogeneous medium with metallic boundaries.

• Numeric modes with the data from a mode analysis made in the Boundary Mode 
Analysis application mode.

• User-defined modes, which lets you enter the expressions for the fields manually. 
The fields can be complex-valued if you like. The Port phase edit field has no impact 
for this mode type because the phase is determined by the entered fields.
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S-Parameter normalization
You control the type of S-parameter normalization that is used via the S-parameter 

output field at the bottom of the Port tab. Here you can choose between Magnitude and 

phase or Magnitude only.

Rectangular and Circular Modes
To specify a unique rectangular mode you need to set a mode type and a mode number.

• Establish whether the mode is a transverse electric (TE) or a transverse magnetic 
(TM) mode using the Mode type list.

• Enter the mode number, for example, 10 for a TE10 mode, or 11 for a TM11 mode. 
In 2D the mode number is a single number. If you select the node number n for an 
in-plane wave this gives you the TEn0 or TMn0 wave. For axisymmetric waves the 
mode number is the mode number for the radial variation of the mode.

Coaxial Modes
Coaxial modes are available in 3D and for axisymmetric TM waves. Only the 
fundamental mode is available as a predefined mode.

Numeric Modes
The numeric option is available only if there is a Boundary Mode Analysis application 
mode in the model. You can take the data for the eigenmode from such a mode analysis 
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and use it in the S-parameter analysis. Specify the mode type of the solution to the 
boundary mode analysis by selecting from the Mode type list:

• Automatic means that the mode type is determined from the settings in the 
Boundary Mode Analysis application mode. This works if you have used the 
Boundary Mode Analysis application mode to calculate TE or TM waves. If 
hybrid-mode waves have been calculated, the mode type cannot be determined 
automatically.

• Use the other options to explicitly specify the mode type: transverse electric (TE), 
transverse magnetic (TM), or transverse electromagnetic (TEM).

If there are more than one Boundary Mode Analysis application mode in the model, 
select which one to use from the Use numeric data from list.

When using a numeric mode the mode analysis and the S-parameter analysis need to 
be done in sequence:

1 Open the Solver Manager and make sure that Current solution option button is active 
for solutions not solved for.
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2 Select only the Boundary Mode Analysis on the Solve For page in the Solver Manager 
and solve that problem. If you have several Boundary Mode Analysis application 
modes, you only select one of them.

3 From the Physics menu, choose Properties to open the Application Mode Properties 
dialog box. From the Specify eigenvalues using list, choose Manual eigenvalue and click 
OK. When you perform this operation, you copy the propagation constant for 
solution currently plotted into an application mode scalar variable for the 
propagation constant. You can also change this value manually by opening the 
Application Scalar Variables dialog box from the Physics menu. All the postprocessing 
variables now use this propagation constant instead of calculating them from the 
eigenvalues. The application mode is now in a frozen state where it makes no sense 
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to solve for eigenvalues. So before re-solving this application mode again, switch 
back to the original setting in the Properties dialog box.

4 If you have several numeric ports, repeat steps 2and 3 for the other Boundary Mode 
Analysis application modes.

5 Then switch from the eigenvalue solver to the stationary solver in the Solver 

Parameters dialog box.

6 Select only the Electromagnetic Waves application mode in the Solver Manager. On 
the Initial Value tab click the Store Solution button to store the result from the mode 
analysis.

7 In the Initial value area, click the Stored solution button and select which solution to 
use. It is important that you select a solution for the eigenvalue that match the 
propagation constant in the scalar variables. When solving the wave propagation 
problem, the port boundary condition uses the stored solution.

When making a parametric study of the S-parameters as a function of frequency it is 
important that you keep the frequency variable for the Boundary Mode Analysis 
application mode constant. Only the frequency variable for the 3D Electromagnetic 
Waves application mode is allowed to vary. When calculating the data in the port 
boundary condition as a function of frequency it is necessary to know for which 
frequency the mode analysis were made. The two frequency variables are found in the 
Application Scalar Variables dialog box, as you can see in Figure 2-8. The Boundary 
Mode Analysis application mode uses the variable nu_rfwb, and the 3D 
Electromagnetic Waves application mode uses the variable nu_rfw. Clear the 
Synchronize equivalent variables check box to be able to edit them individually. The 
suffixes of the variable names, _rfwb and _rfw, determine which variables is which. 
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The suffix is given by the application mode name. The names used here are the default 
names.

Figure 2-8: The Application Scalar Variables dialog box with the variables for the 
Boundary Mode Analysis and 3D Electromagnetic Waves application mode.

User-Defined Modes
Using the user-defined mode type you can manually specify the eigenmode of the port. 
To fully specify the mode enter the following data:

• Select the mode type. The available options are transverse electric (TE), transverse 
magnetic (TM), and transverse electromagnetic (TEM).

• Enter the amplitude of the electromagnetic field in terms of either the electric or the 
magnetic field.

• The propagation constant can be given in three different ways. One method is to 
only specify the propagation constant β for the current frequency. This identical to 
the way the matched boundary condition is specified. The only difference is that the 
port boundary condition uses a normalization to a certain power.

The next method is to specify a reference frequency ν0 and the propagation constant 
β0 for that frequency. The propagation constant as a function of frequency is then 
calculated as

The third option is to specify the cutoff frequency, νcutoff. The propagation constant 
as a function of frequency is in this case calculated as

β β0
2 4π2εµ ν0

2 ν2
–( )–=

β 4π2εµ ν2 νcut-off
2

–( )=
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See Figure 2-9 on page 63, which shows where to enter these settings in the Subdomain 

Settings dialog box.

Figure 2-9: Specification of the mode type, electric field components, and the propagation 
constant.

S-Parameter Variables

The RF Module automatically generates variables for the S-parameters. The port 
numbers determine the variable names. If you, for example, have two ports with the 
numbers 1 and 2 and Port 1 is the inport, the software generates the variables S11_rfw 
and S21_rfw. S11_rfw is the S-parameter for the reflected wave and S21_rfw is the 
S-parameter for the transmitted wave. For convenience, two variables for the 
S-parameters on a dB scale, S11dB_rfw and S21dB_rfw, are also defined using the 
following relation:

The application mode name determines the suffix in the variable names (in this case 
_rfw), so it may vary.

S11dB 20 10 S11( )log=
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The S-parameter variables are added to the Predefined quantities plot lists of the 
following postprocessing dialog boxes:

• Global Plot Variables. Open with Postprocessing>Global Plot Variables.

• Global Data Display. Open with Postprocessing>Data Display>Global.

• Domain Plot Parameters. Open with Postprocessing>Domain Plot Parameters, and 
under the Point tab choose an arbitrary point.

• Point Evaluation. Open with Postprocessing>Point Evaluation. Choose an arbitrary 
point.
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Note: When displaying S-Parameter variables, the phase of the solution must be set 
to zero. Otherwise, incorrect values will be displayed. In the various dialog boxes for 
displaying and plotting data that are available from the Postprocessing menu, you can 
set the phase of the solution via the Solution at angle (phase) edit field. If the dialog 
box contains several tabs, it usually appears on the General tab.

Parametric Studies

Once the boundary condition is set up it is easy to make a parametric study using the 
parametric solver. Use the parametric solver and introduce a parameter representing 
the frequency. Set the frequency variable of the 3D Electromagnetic Waves application 
mode to this parameter in the Application Scalar Variables dialog box.

To plot the S-parameters as a function of frequency use the Global Plot Variables or 
Domain Plot Parameters dialog box. The S-parameter variables are available in the list 
of Predefined quantities. The S-parameters are global variables, so they are available at 
all levels in a geometry.

Calculations Below the Cutoff Frequency

When doing S-parameter calculations below the cutoff frequency you may get an error 
message saying Attempt to evaluate real square root of negative number. This is because 
the propagation constant is calculated as the square root of an expression which 
becomes negative. The default solver settings do not allow you to take the square root 
of real numbers. To overcome the problem select the Use complex functions with real 

input check box on the Advanced tab in the Solver Parameters dialog box.

Model with S-Parameter Calculations

For an example of how to use the boundary condition described above to make an 
S-parameter analysis, see the model “Waveguide Adapter” on page 85 in the RF 
Module Model Library. The model “Microstrip on a Printed Circuit Board” on page 
20 in the RF Module Model Library has a detailed description how to model 
numerical ports with a boundary mode analysis application mode.
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S-Parameter Matrix Extraction and Export

In many situations it is of interest to calculate the entire S-parameter matrix, where 
each port in the model is used as input port. This is possible to do at the COMSOL 
Script command line using the function sparametermatrix. In addition, if the 
S-parameter calculation is made as a frequency sweep, it is possible to export the 
frequency-dependent S-parameter matrix to a Touchstone file with the command 
touchwrite. See Chapter 4, “Function Reference,” of the RF Module Reference 
Guide for more information about these commands. For an example of how to use 
them, see the model “Three-Port Ferrite Circulator” on page 32 of the RF Module 
Model Library.

Ports and Assemblies

You can declare ports for an assembly pair, and such ports behaves a bit different than 
ordinary ports. An assembly pair condition can allow a discontinuity in the solution 
field variables across the pair interface. This is used to remove the incident field on one 
side of the interface. The incident field can then travel into a waveguide, but the 
reflected waves just pass the interface and into the other side unaltered. The other side 
can be a PML region that effectively damps all types of reflected waves. This is useful 
for multimode simulations where the port boundary gives reflections on higher modes 
than it is designed for.

The incident wave travels into the master side of a pair. The slave side gets the wave 
without the incident field. It is therefore important to verify that the master-slave 
selection is correct in the Identity Boundary Pair dialog box. You open that dialog box 
from the Physics menu by choosing Identify Pairs>Identity Boundary Pairs.

For an example how to set up these assembly ports, see the model “Coaxial to 
Waveguide Coupling” on page 157 of the RF Module Model Library.

Note: Using analytical ports on assembly interfaces require that imprints are used or 
that the master and slave side are identical. Otherwise the analytical mode is 
calculated on the entire master boundary and the mode does not represent a true 
mode of the interface.
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Lumped Po r t s  w i t h  Vo l t a g e  I n pu t

The ports described in the previous section require a detailed specification of the 
mode, including the propagation constant and field profile. In situations when the 
mode is difficult to calculate or when there is an applied voltage to the port, a lumped 
port might be a better choice. The lumped port is not as accurate as the ordinary port 
in terms of calculating S-parameters, but it is easier to use. You can, for example, attach 
a lumped port as an internal port directly to a printed circuit board or to the 
transmission line feed of a patch antenna. The lumped port must be applied between 
two metallic objects separated by a distance much smaller than the wavelength.

A lumped port specified as an input port calculates the impedance, Zport, and S11 
S-parameter for that port. The parameters are directly given by the relations

where Vport is the extracted voltage for the port given by the line integral between the 
terminals averaged over the entire port. The current Iport is the averaged total current 
over all cross sections parallel to the terminals. Ports not specified as input ports only 
return the extracted voltage and current. You can find more details on how to use 
voltages and currents in the boundary condition in “Lumped Port Parameters” on 
page 98.

Lumped Ports in the RF Module

Not all application modes can use lumped ports due to the polarization of the fields 
and how sources are specified. In 2D and axial symmetry only the transient analysis 
type for TM and hybrid-mode waves can use lumped ports. In 3D you can use them 
if you solve for the electric field in a time-harmonic or transient analysis. Neither 
eigenfrequency nor scattered field analyses can use lumped ports. For the application 
modes and analysis types that supports the lumped port, you find the Lumped port 
boundary condition in the Boundary condition list.

Zport
Vport
Iport
-------------=

S11
Vin

Vport Vin–
----------------------------=
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T H E  C O E F F I C I E N T  P A G E

When you select Lumped port from the Boundary condition list, the dialog box provides 
inputs for specifying the port number and the port’s voltage and phase.

Each port must have a unique port number. To connect a voltage generator at a port, 
select the Voltage generator at this port check box for that port.

To adjust the voltage of a port with a voltage generator, use the Vin edit field. For 
time-harmonic simulations it is also possible to enter a phase shift for the input signal 
in the Port phase edit field.

T H E  P O R T  P A G E

Just as for the port boundary condition, the Port page gets enabled when you select a 
lumped port boundary condition. For lumped ports, this page provides an interface 
for specifying the impedance of the external cable attached to the port and the shape 
of the port area. Depending on the dimension, you can specify three different types of 
port shapes:

• Uniform shapes where the are two parallel metallic boundaries on both sides of the 
port area. This selection is not available for axial symmetry.

• Coaxial shape where the port area terminates two concentric cylinders of metallic 
boundaries. This selection is available for 3D and axial symmetry.

• User-defined shapes where you manually specify all the parameters necessary for the 
lumped port: the height of the port, the width of the port, and the voltage reference 
direction. The height of the port is the distance between the metallic boundaries. 
The voltage reference direction defines the line integral to get the voltage from the 
electric field. The width of the port is an effective width to convert between wave 
impedance and characteristic impedance of the cable.

Example Model—Microstrip on a Printed Circuit Board

For an example of how to use the lumped port boundary condition, see the model 
“Microstrip on a Printed Circuit Board” on page 20 in the RF Module Model Library.
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S o l v i n g  L a r g e  3D P r ob l em s

For large 3D electromagnetic problems, where the default direct linear solver requires 
too much memory, you can use the iterative linear solver GMRES together with the 
geometric multigrid (GMG) preconditioner for wave problems. This section describes 
how to use the set up the iterative solvers in the context of electromagnetic wave 
simulations. You can find general information about the geometric multigrid solver in 
the section “The Geometric Multigrid Solver/Preconditioner” on page 518 in the 
COMSOL Multiphysics Reference Guide.

Hierarchy Generation

There are several types of hierarchy used by the geometric multigrid preconditioner. 
The default is to use the element order, where the coarsest mesh usually is the 1st order 
element. The finer hierarchy can then be either quadratic or cubic vector elements. It 
can also use a hierarchy of meshes, where the finer meshes in the hierarchy have to be 
obtained by refining the coarsest mesh. It is also possible to manually make all the 
meshes using the Mesh Cases dialog box and tell the preconditioner to use these 
meshes; see the section “Hierarchy Generation Method” on page 70.

Note: The solver calculates the solution for the finest of the meshes in the hierarchy. 
Therefore, when you let the preconditioner generate the meshes automatically, you 
obtain a solution for a much finer mesh than the one you have made.

C O N S T R A I N T S  O N  T H E  C O A R S E S T  M E S H

The coarsest mesh cannot be arbitrarily coarse, because then the iterative solver does 
not converge. For wave problems, for instance, the minimum requirement is that there 
are at least two mesh elements per wavelength in the geometry. This is the Nyquist 
criterion. Keep in mind that the wavelength varies with the material properties and 
that the mesh has to resolve the waves in the whole geometry.

A direct solver is used to solve the equation on the coarsest mesh. Therefore you 
should try to make the mesh as coarse as possible while still fulfilling the Nyquist 
criterion of two mesh elements per wavelength.
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Solver Settings

Electromagnetic wave problems depend on the geometric multigrid solver (used as 
preconditioner), and this solver relies on a hierarchy of meshes. The next section 
describes the options you have when you create the hierarchy, because this is crucial 
for a converging solution in most cases.

H I E R A R C H Y  G E N E R A T I O N  M E T H O D

There are several hierarchy generation methods that you can use with the geometric 
multigrid solver, and not all are suitable for electromagnetic problems. You select them 
from the Hierarchy generation method list in the Linear System Solver Settings dialog 
box. The default is Lower element order first. This option finds the lower-order 
elements and use them as coarser levels. Another option is Refine mesh, which 
automatically generates the finer meshes in the hierarchy. The Manual option lets you 
pick a set of meshes that you have created beforehand. If you solve with the Refine mesh 
option, the solve step stores the generated meshes and automatically switches to the 
Manual option.

Figure 2-10: The multigrid settings for the GMG preconditioner.

Lower Element Order
The use of higher-order vector elements opens up the possibility to use different 
element orders in the hierarchy. You have to use a vector element order of at least 2. 
Specify the element order either at model creation in the Model Navigator or in the 
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Subdomain Settings dialog box under the Element tab. The default vector element order 
is 2, so the default hierarchy is 1st order on the coarsest level and 2nd order on the 
finest level. This is a robust setting that often produce convergence. Another efficient 
option is to use 3rd order as the finest level and 1st order on the coarsest level. The 
main drawback with 3rd order vector elements is that they produce around 20 degrees 
of freedoms (DOF) per mesh element, which sometimes makes it hard to resolve the 
geometry and keep the number of DOF at a reasonable level. The same figure for 2nd 
order is around 6.5 DOF per mesh element. Generally, it is best to use as high order 
as you can because the overall error is often lower for higher-order elements with the 
same number of DOF.

Refine Mesh
The refine mesh option automatically generates finer meshes. The settings on the 
Automatic tab determines how this refinement is done.

• Number of levels determines how many meshes the mesh refinement generates, that 
is, how many times the original mesh is refined. This number is the total number of 
meshes including the original mesh. For example, the default number 2 gives you 
one refinement.

• The Refinement method specifies how the mesh is refined. See the section 
“Refinement Methods” on page 327 in the COMSOL Multiphysics User’s Guide 
for general information about the refinement methods. Regular refinement creates 
finer meshes than the Longest method.

These two parameters often have to be tuned given how coarse the original mesh is. If 
the original mesh just fulfills the Nyquist criterion of two mesh elements per 
wavelength, then two regular refinements are needed to obtain an accurate solution. 
If, on the other hand, the original mesh is finer, for example, because the geometry 
makes it difficult to make it coarser, then two regular refinements might give a too fine 
mesh, making the solvers use more memory than necessary. If so, one regular 
refinement can be sufficient or the longest method might be a better choice.

Manual
Manual hierarchy generation lets you pick meshes that you have made manually. This 
gives you better control of which meshes the solver uses. To create a set of meshes use 
the Mesh Cases dialog box in the Mesh menu and create as many mesh cases as the 
number of meshes you need. Then switch between the mesh cases by selecting them 
in the Mesh menu and mesh the geometry for each mesh case. Make the mesh of each 
mesh case finer than the previous one. Alternatively, you can select the element order 
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manually in the Subdomain Settings for each mesh case, and use the same mesh for both 
mesh cases.

Figure 2-11: Settings for using the same mesh for both mesh cases.

Note: The meshes must be made by refining the coarsest one if you use the same 
element order.

On the Manual tab of the Linear System Solver Settings dialog box, select the meshes 
you want to use. Make sure Assemble is selected for all meshes.

S O L V E R  S E T T I N G S  F O R  E L E C T R O M A G N E T I C  W AV E S

In most cases it is sufficient to use the default setting, which is GMRES for the Linear 

system solver list and Geometric multigrid for the Preconditioner list. In other cases it is 
necessary to adjust how the solver generates the mesh hierarchy or fine tune the solver 
settings.
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Figure 2-12: The default settings for electromagnetic waves.

Presmoother
The default presmoother is SOR vector.

Figure 2-13: The default presmoother settings (figure shows part of dialog box).
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Postsmoother
The default postsmoother is SORU vector.

Figure 2-14: The default postsmoother settings (figure shows part of dialog box).

Coarse Solver
The default coarse solver is SPOOLES.

Figure 2-15: The default coarse solver settings (figure shows part of dialog box).

Note: When the 3D Electromagnetic Waves application mode is the single 
application mode in the model, it automatically adjusts the default values of the solver 
settings described above to values which are suitable for the calculation. If the 3D 
Electromagnetic Waves application mode is part of a multiphysics model the default 
settings might not be suitable for waves. In that case, make sure you adjust all settings 
as described in the sections above. Models involving periodic 3D wave problems also 
require manual adjustment of the solver settings as described in the following section.

S O L V E R  S E T T I N G S  F O R  P E R I O D I C  3 D  WA V E  P R O B L E M S

If you use periodic boundary conditions in 3D, you cannot use the settings described 
above due to the added divergence condition (see “Periodic Boundary Conditions” on 
page 37). This section also apply to problems using assembly interfaces with 
incompatible meshes (see “Using Assemblies in Electromagnetic Problems” on page 
84). To set up an iterative solver for such problems, you must use geometric multigrid 
with the Vanka preconditioner. Select Geometric multigrid in the Linear system solver 
list, and set the presmoother and postsmoother to Vanka, which is configured with 
suitable defaults for large 3D problems. In some cases it is necessary to adjust how the 
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solver generates the mesh hierarchy and fine tune the settings for the Vanka 
preconditioner.

Figure 2-16: Solver settings for periodic 3D wave problems.

For geometric multigrid with Vanka the preferred setting for the Multigrid cycle is 
F-cycle in contrast to wave problems where it is V-cycle.

Figure 2-17: The multigrid settings for periodic 3D wave problems (the figure shows only 
the upper part of the dialog box).

As an alternative to the geometric multigrid solver you can also use the GMRES linear 
system solver. As preconditioner you can either choose Vanka or geometric multigrid 
with Vanka as pre- and postsmoother. The default settings are the same as those 
described below.
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Presmoother
The presmoother must be set to Vanka. The dialog box shows the default settings.

Figure 2-18: The default presmoother settings (the figure shows only the upper part of the 
dialog box).

The default setting for Variables is psi, which is the default variable name used by the 
divergence condition. This default setting does not change if you specify a different 
name for that variable, and then you have to update this setting manually for both the 
presmoother and the postsmoother.

Postsmoother
The postsmoother must be set to Vanka. The default settings are the same as for the 
presmoother.

Figure 2-19: The default postsmoother settings (the figure shows only the upper part of the 
dialog box).
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Coarse Solver
The preferred coarse solver is PARDISO.

Figure 2-20: The coarse solver settings (the figure shows only the upper part of the dialog 
box).

After Solving

When you have solved using automatic generation of the mesh hierarchy using the 
Refine mesh method, you can find the meshes as mesh cases in the Mesh menu. The 
finest mesh is the one that the solver used to calculate the final solution, and it shows 
how well the geometry has been resolved.

When you have solved using the refine mesh hierarchy, the Hierarchy generation method 
in the Linear Solver Settings dialog box switches to Manual. This means that if you solve 
again, the solver uses the same meshes.

If you want to use the refine mesh generation again but with different refinement 
parameters or another coarse mesh, you have to change the Hierarchy generation 

method back to Refine mesh. Then another set of meshes is generated. Using the Mesh 

Cases dialog box, you can delete the additional meshes that were used for the previous 
solution but are no longer used.

If you solve using the Lower element order first method, the hierarchy is generated on 
the current mesh each time you solve, so you do not have to adjust any solver 
parameters.
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L o s s y  E i g e n v a l u e  C a l c u l a t i o n s

In mode analysis and eigenfrequency analysis, it is usually the primary goal to find a 
propagation constant or an eigenfrequency. These quantities are often real valued 
although it is not necessary. If the analysis involves some lossy part, like a nonzero 
conductivity or an open boundary, the eigenvalue is complex. In such situations, the 
eigenvalue is interpreted as two parts:

• The propagation constant or eigenfrequency

• The damping in space and time

Eigenfrequency Analysis

The eigenfrequency analysis solves for the eigenfrequency of a model. This analysis 
type is available for all application modes in the RF Module. The time-harmonic 
representation of the fields is more general and includes a complex parameter in the 
phase

where the eigenvalue, (−λ) = δ + jω, has an imaginary part representing the 
eigenfrequency, and a real part responsible for the damping. It is often more common 
to use the quality factor or Q-factor, which is derived from the eigenfrequency and 
damping

V A R I A B L E S

The following list shows the variables that the eigenvalues analysis affects:

NAME EXPRESSION CAN BE COMPLEX DESCRIPTION

omega imag(-lambda) No Angular frequency

damp real(lambda) No Damping in time

Qfact 0.5*omega/abs(damp) No Quality factor

nu omega/(2*pi) No Frequency

E r t,( ) Re E
˜

rT( )ejωt( ) Re E
˜

r( )e λ– t( )= =

Qfact
ω

2 δ
---------=
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N O N L I N E A R  E I G E N F R E Q U E N C Y  P R O B L E M S

For some combinations of formulation, material parameters and boundary conditions, 
the eigenfrequency problem can be nonlinear, which means that the eigenvalue enters 
the equations in another form than the expected second-order polynomial form. The 
following table lists those combinations:

These situations require special treatment, especially since it can lead to singular matrix 
messages if not treated correctly. The complication is not only the nonlinearity itself, 
it is also the way it enters the equations. For example the impedance boundary 
conditions with nonzero boundary conductivity has the term

where (−λ) = δ + jω. When the solver starts to solve the eigenfrequency problem it 
linearizes the entire formulation with respect to the eigenvalue around a certain 
linearization point (see the “The Eigenvalue Solver” on page 376 of the COMSOL 
Multiphysics User’s Guide for more information). By default this linearization point is 
zero, which leads to a division by zero in the expression above. To avoid this problem 
and also to give a suitable initial guess for the nonlinear eigenvalue problem, it is 
necessary to provide a “good” linearization point for the eigenvalue solver. You can do 
this in the Solver Parameters dialog box, under the Eigenfrequency tab, by entering a 
new complex value in the Eigenvalue linearization point edit field. For example, if you 

SOLVE FOR CRITERION BOUNDARY CONDITION

H Nonzero conductivity

H, E Nonzero conductivity Impedance boundary 
condition

H, E Nonzero conductivity at 
adjacent subdomain

Scattering boundary 
condition

H, E Nonzero conductivity at 
adjacent subdomain

Scattering boundary 
condition

H, E Analytical ports Port boundary condition

λ–( )
ε0µ0 µrbnd

εrbnd
σbnd

λ–( )ε0
-----------------+

------------------------------------------ n n H×( )×( )–
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know that the eigenfrequency is close to 1 GHz, enter the eigenvalue -i*2*pi*1e9 in 
the edit field.

In many cases it is enough to specify a good linearization point and then solve the 
problem once. If you need a more accurate eigenvalue, an iterative scheme is necessary:

1 Specify that the eigenvalue solver only search for one eigenvalue.

2 Solve the problem with a “good” linearization point. As the eigenvalues shift, use 
the same value with the real part removed.

3 Extract the eigenvalue from the solution and update the linearization point and the 
shift.

4 Repeat until the eigenvalue does not change more than a desired tolerance.

A solver script provides the most convenient way to use this procedure.

Mode Analysis

In mode analysis COMSOL Multiphysics solves for the propagation constant, which 
is possible for the Perpendicular Waves and Boundary-Mode Analysis application 
modes. The time-harmonic representation is almost the same as for the eigenfrequency 
analysis, but with a know propagation in the out-of-plane direction
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The spatial parameter, α = δz + jβ = −λ, can have a real part and an imaginary part. The 
propagation constant is equal to the imaginary part, and the real part, δz, represents 
the damping along the propagation direction.

VA R I A B L E S

The following table lists the variables that are influenced by the eigenfrequency 
analysis:

Example Model—Circular Waveguide with Lossy Walls

This model finds the modes of a circular waveguide with walls made of a nonperfect 
conductor, which is copper in this case. The losses in the walls lead to attenuation of 
the propagating wave. The attenuation in dB scale is calculated using the formula

which is available as the variable dampzdB_rfwv. The first six eigenvalues show the 
following attenuation per km for a propagating wave with a frequency of 1 GHz.

NAME EXPRESSION CAN BE COMPLEX DESCRIPTION

beta imag(-lambda) No Propagation constant

dampz real(-lambda) No Attenuation constant

dampzdB 20*log10(exp(1))
*dampz

No Attenuation per meter in dB

neff j*lambda/k0 Yes Effective mode index

EFFECTIVE MODE INDEX PROPAGATION CONSTANT ATTENUATION

0.931 + 1.9e-6i 19.51 rad/m 0.34 dB/km

0.957 + 1.1e-6i 20.05 rad/m 0.20 dB/km

0.957 + 1.2e-6i 20.05 rad/m 0.22 dB/km

0.973 + 1.3e-6i 20.40 rad/m 0.24 dB/km

0.984 + 4.4e-7i 20.63 rad/m 0.08 dB/km

0.984 + 7.6e-007i 20.63 rad/m 0.14 dB/km

E r t,( ) Re E
˜

rT( )ejωt jβz–( ) Re E
˜

r( )ejωt αz–( )= =

∆dB 20δz elog=
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Model Library path:  
RF_Module/Tutorial_Models/lossy_circular_waveguide

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 In the Model Navigator select 2D from the Space dimension list.

2 Open the RF Module folder, then select Perpendicular Waves> 
Hybrid-Mode Waves>Mode analysis.

3 Click OK.

G E O M E T R Y  M O D E L I N G

Use Specify Objects>Circle under the Draw menu to create a circle with radius 0.5.

P H Y S I C S  S E T T I N G S

Subdomain Settings
Use the default settings for the subdomain.

Boundary Conditions
1 Open the Boundary Settings dialog box from the Physics menu.

2 Select all boundaries and choose the Impedance boundary condition from the 
Boundary condition list.

3 Click the Material Properties tab, click the Load button, and select Copper from the 
list of materials in the dialog box that appears.

4 Click OK twice to close the Material/Coefficients Library dialog box and the Boundary 

Settings dialog box in that order.

C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button on the Main toolbar to solve the problem with the default mesh 
and solver settings.
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PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The default plot shows the z-component of the time-averaged power flow for the first 
eigenmode in the table on page 81.

To calculate the attenuation values in the third column of the table, do as follows:

1 Open the Global Data Display dialog box by choosing Data Display>Global from the 
Postprocessing menu.

2 Enter 1000*dampzdB_rfwv in the Expression edit field and click Apply.

This produces the first value for the third column in the table on page 81.

3 Go through the other entries in the Effective mode index list to get the full table.
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U s i n g  A s s emb l i e s  i n  E l e c t r omagne t i c  
P r ob l em s

The use of assemblies in models can simplify and improve several aspects of modeling. 
For electromagnetic applications it can be used to make devices move and rotate with 
the sliding mesh technique. Another situation when assemblies come in handy is when 
you need to introduce a discontinuity for the solution variable at an interface. Such 
interface conditions are generally called slit boundary conditions. For example, an 
internal perfect electrical conductor when solving for the magnetic field needs a slit 
boundary condition because the solution variable becomes discontinuous across that 
interface. The sliding mesh interface can also be seen as a slit boundary. A third 
example of assembly usage is when you want to mix mesh element types and mesh 
resolution, because you can mesh the two neighboring parts of the assembly 
independently. You can mix element without using assemblies as long as the boundary 
mesh elements at an interface are the same. This is true for interfaces between 
quadrilateral and triangular elements in 2D and for tetrahedral elements facing the 
triangular bases of the prism elements in 3D.

Although assemblies simplifies several task in modeling, there are a few important rules 
and recommendations that need consideration, and these are covered in the following 
sections.

A S S E M B L I E S  A N D  V E C T O R  E L E M E N T S

If you use an application mode with vector elements it might be necessary to activate 
the divergence condition. This is the same type of divergence condition that you need 
when solving with periodic boundary condition (see “Periodic Boundary Conditions” 
on page 37). The only situation where you do not need the divergence condition is 
when the boundary meshes on each side of the assembly interface are identical.

For 2D problems, for which you can use direct solvers, activating the divergence 
condition usually does not cause any trouble. It is when you solve 3D problems with 
iterative solvers that you need to know wether the divergence condition is activated or 
not. When it is activated there is an extra solution variable, psi, added to the problem 
that needs the Vanka preconditioner/solver with psi as Vanka variable. You can find 
details about these solver settings in “Solving Large 3D Problems” on page 69.
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The following list summarizes the application modes in the RF Module that use vector 
elements:

• 3D electromagnetic waves.

• Transient in-plane waves for TM and hybrid-mode polarizations.

• Perpendicular hybrid-mode waves. This application mode does not support the use 
of a divergence condition.

Generally, if it is possible to avoid activating the divergence condition you should do 
that. The problem is much tougher to solve when it is activated in terms of solution 
time and memory usage. There are techniques to create compatible (or identical) 
meshes, and these are briefly described below.

Compatible Meshes
Use interactive meshing and mesh only the source or destination side of pair 
boundaries first. Then select both source and destination boundaries and click the Copy 

Mesh button on the Mesh toolbar. You can read more about the copy mesh feature in 
“Copying Meshes” on page 342 of the COMSOL Multiphysics User’s Guide.

Note: For a sliding mesh interface it is not possible to generate compatible meshes. A 
mesh that is compatible at a one time is probably not compatible at a later time when 
the destination side has moved slightly.

A S S E M B L I E S  A N D  WE A K  C O N S T R A I N T S

It might be necessary to use weak constraints to improve the accuracy at the assembly 
interface. Especially when the interface is a sliding mesh interface. Weak constraints 
also add extra complexity for the settings of the iterative solvers, so it might not be 
possible to use them for large 3D problems. Below are a few recommendations when 
to use and how to use weak constraints for assemblies:

• If you have a transient problem with a moving assembly interface that fails to 
converge after some time, you might get better convergence if you turn on weak 
constraints.

• The recommendation is generally to mesh the destination boundary finer than the 
source boundary, but it is not as crucial when you use weak constraints.

• When you turn on weak constraints, it is activated for all boundaries with constraints 
on the solution variable, and for all boundaries with coupling through assembly 
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pairs (for example, identity pairs). The difference in magnitude of the Lagrange 
multiplier between the assembly pairs and other constraints can be several orders of 
magnitude, which can cause convergence problems and even a singular matrix error. 
If you get such problems, it is recommended to deactivate the weak constraints 
manually for all other constraints except the assembly pair slave boundaries. Note 
that you should also deactivate the weak constraints for the master side. You do this 
by clearing the Use weak constraints check box on the Weak Constr. tab in the 
Boundary Settings dialog box.

E X A M P L E  M O D E L

A model that uses assemblies with vector elements and identical boundary meshes is 
the “Coaxial to Waveguide Coupling” on page 157 of the RF Module Model Library.
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R e v i e w  o f  E l e c t r o m a g n e t i c s
This chapter contains a review of the basic theory of electromagnetics, starting 
with Maxwell’s equations, and the theory for some special calculations: 
S-parameters, lumped port parameters, and far-field postprocessing. There is also a 
list of electromagnetic quantities with their SI units and symbols.
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Maxwe l l ’ s  Equa t i o n s

The problem of electromagnetic analysis on a macroscopic level is the problem of 
solving Maxwell’s equations subject to certain boundary conditions. Maxwell’s 
equations are a set of equations, written in differential or integral form, stating the 
relationships between the fundamental electromagnetic quantities. These quantities 
are the electric field intensity E, the electric displacement or electric flux density D, the 
magnetic field intensity H, the magnetic flux density B, the current density J and the 
electric charge density ρ.

The equations can be formulated in differential or integral form. The differential form 
are presented here, because it leads to differential equations that the finite element 
method can handle. For general time-varying fields, Maxwell’s equations can be 
written as

The first two equations are also referred to as Maxwell-Ampère’s law and Faraday’s law, 
respectively. Equation three and four are two forms of Gauss’ law, the electric and 
magnetic form, respectively. 

Another fundamental equation is the equation of continuity, which can be written as

Out of the five equations mentioned, only three are independent. The first two 
combined with either the electric form of Gauss’ law or the equation of continuity 
form such an independent system. 

Constitutive Relations

To obtain a closed system, the constitutive relations describing the macroscopic 
properties of the medium, are included. They are given as

∇ H× J D∂
t∂

-------+=

∇ E× B∂
t∂

-------–=

∇ D⋅ ρ=

∇ B⋅ 0=

∇ J⋅ ρ∂
t∂

------–=
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Here ε0 is the permittivity of vacuum, µ0 is the permeability of vacuum, and σ the 
electric conductivity. In the SI system, the permeability of vacuum is chosen to be  
4π·10−7 H/m. The velocity of an electromagnetic wave in vacuum is given as c0 and 
the permittivity of vacuum is derived from the relation

The electric polarization vector P describes how the material is polarized when an 
electric field E is present. It can be interpreted as the volume density of electric dipole 
moments. P is generally a function of E. Some materials can have a nonzero P also 
when there is no electric field present.

The magnetization vector M similarly describes how the material is magnetized when 
a magnetic field H is present. It can be interpreted as the volume density of magnetic 
dipole moments. M is generally a function of H. Permanent magnets, for instance, 
have a nonzero M also when there is no magnetic field present.

For linear materials, the polarization is directly proportional to the electric field, 
P = ε0χeE, where χe is the electric susceptibility. Similarly in linear materials, the 
magnetization is directly proportional to the magnetic field, M = χmH, where χm is the 
magnetic susceptibility. For such materials, the constitutive relations can be written

The parameter εr is the relative permittivity and µr is the relative permeability of the 
material. These are usually scalar properties but they can, for a general anisotropic 
material, be 3-by-3 tensors. The properties ε and µ (without subscripts) are the 
permittivity and permeability of the material.

G E N E R A L I Z E D  C O N S T I T U T I V E  R E L A T I O N S

Generalized forms of the constitutive relations are well suited for modeling nonlinear 
materials. The relation used for the electric fields is

D ε0E P+=

B µ0 H M+( )=

J σE=

ε0
1

c0
2µ0

---------- 8.854 10 12–  F/m 1
36π
--------- 10 9–  F/m⋅≈⋅= =

D ε0 1 χe+( )E ε0εrE εE= = =

B µ0 1 χm+( )H µ0µrH µH= = =

D ε0εrE Dr+=
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The field Dr is the remanent displacement, which is the displacement when no electric 
field is present.

Similarly, a generalized form of the constitutive relation for the magnetic field is

where Br is the remanent magnetic flux density, which is the magnetic flux density 
when no magnetic field is present.

The relation defining the current density is generalized by introducing an externally 
generated current Je. The resulting constitutive relation is

Potentials

Under certain circumstances it can be helpful to formulate the problems in terms of 
the electric scalar potential V and the magnetic vector potential A. They are given 
by the equalities

The defining equation for the magnetic vector potential is a direct consequence of the 
the magnetic Gauss’ law. The electric potential results from Faraday’s law.

In the magnetostatic case where there are no currents present, Maxwell-Ampère’s law 
reduces to . When this holds, it is also possible to define a magnetic scalar 
potential by the relation

Electromagnetic Energy

The electric and magnetic energies are defined as 

B µ0µrH Br+=

J σE Je
+=

B ∇ A×=

E ∇V–
A∂
t∂

-------–=

∇ H× 0=

H ∇Vm–=

We E Dd⋅
0

D

∫⎝ ⎠
⎛ ⎞ Vd

V∫ E D∂
t∂

-------⋅ td
0

T

∫⎝ ⎠
⎛ ⎞ Vd

V∫= =

Wm H Bd⋅
0

B

∫⎝ ⎠
⎛ ⎞ Vd

V∫ H B∂
t∂

-------⋅ td
0

T

∫⎝ ⎠
⎛ ⎞ Vd

V∫= =
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The time derivatives of these expressions are the electric and magnetic power

These quantities are related to the resistive and radiative energy, or energy loss, 
through Poynting’s theorem [3]

where V is the computation domain and S is the closed boundary of V.

The first term on the right-hand side represents the resistive losses,

which result in heat dissipation in the material. (The current density J in this 
expression is the one appearing in Maxwell-Ampère’s law.)

The second term on the right-hand side of Poynting’s theorem represents the radiative 
losses,

The quantity S = E × H is called the Poynting vector.

Under the assumption the material is linear and isotropic, it holds that

By interchanging the order of differentiation and integration (justified by the fact that 
the volume is constant and the assumption that the fields are continuous in time), you 
get

Pe E D∂
t∂

-------⋅ Vd
V∫=

Pm H B∂
t∂

-------⋅ Vd
V∫=

E D∂
t∂

-------⋅ H B∂
t∂

-------⋅+⎝ ⎠
⎛ ⎞ Vd

V∫– J E⋅ Vd
V∫ E H×( ) n⋅ dS

S∫°+=

Ph J E⋅ Vd
V∫=

Pr E H×( ) n⋅ dS
S∫°=

E D∂
t∂

-------⋅ εE E∂
t∂

-------⋅
t∂

∂ 1
2
---εE E⋅⎝ ⎠
⎛ ⎞= =

H B∂
t∂

-------⋅ 1
µ
---B B∂

t∂
-------⋅

t∂
∂ 1

2µ
-------B B⋅⎝ ⎠
⎛ ⎞= =

t∂
∂ 1

2
---εE E⋅ 1

2µ
-------B B⋅+⎝ ⎠

⎛ ⎞ Vd
V∫– J E⋅ Vd

V∫ E H×( ) n⋅ dS
S∫°+=
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The integrand of the left-hand side is the total electromagnetic energy density

Material Properties

Until now, there has only been a formal introduction of the constitutive relations. 
These seemingly simple relations can be quite complicated at times. There are four 
main groups of materials where they require some consideration. A given material can 
belong to one or more of these groups. The groups are:

• Inhomogeneous materials

• Anisotropic materials

• Nonlinear materials

• Dispersive materials

The least complicated of the groups above is that of the inhomogeneous materials. An 
inhomogeneous medium is one where the constitutive parameters vary with the space 
coordinates, so that different field properties prevail at different parts of the material 
structure.

For anisotropic materials, the field relations at any point are different for different 
directions of propagation. This means that a 3-by-3 tensor is required to properly 
define the constitutive relations. If this tensor is symmetric, the material is often 
referred to as reciprocal. In these cases, the coordinate system can be rotated in such 
a way that a diagonal matrix is obtained. If two of the diagonal entries are equal, the 
material is uniaxially anisotropic. If none of the elements have the same value, the 
material is biaxially anisotropic (Ref. 2). An example where anisotropic parameters are 
used is for the permittivity in crystals (Ref. 2).

Nonlinearity is the effect of variations in permittivity or permeability with the intensity 
of the electromagnetic field. This also includes hysteresis effects, where not only the 
current field intensities influence the physical properties of the material, but also the 
history of the field distribution.

Finally, dispersion describes changes in the velocity of the wave with wavelength. In 
the frequency domain, dispersion is expressed by a frequency dependence in the 
constitutive laws.

w we wm+=
1
2
---εE E⋅ 1

2µ
-------B B⋅+=
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Boundary and Interface Conditions

To get a full description of an electromagnetic problem, you also need to specify 
boundary conditions at material interfaces and physical boundaries. At interfaces 
between two media, the boundary conditions can be expressed mathematically as

where ρs and Js denote surface charge density and surface current density, 
respectively, and n2 is the outward normal from medium 2. Of these four conditions, 
only two are independent. One of the first and the fourth equations, together with one 
of the second and third equations, form a set of two independent conditions. 

A consequence of the above is the interface condition for the current density,

I N T E R F A C E  B E T W E E N  A  D I E L E C T R I C  A N D  A  P E R F E C T  C O N D U C T O R

A perfect conductor has infinite electric conductivity and thus no internal electric field. 
Otherwise, it would produce an infinite current density according to the third 
fundamental constitutive relation. At an interface between a dielectric and a perfect 
conductor, the boundary conditions for the E and D fields are simplified. If, say, 
subscript 1 corresponds to the perfect conductor, then D1 = 0 and E1 = 0 in the 
relations above. For the general time-varying case, it holds that B1 = 0 and H1 = 0 as 
well (as a consequence of Maxwell’s equations). What remains is the following set of 
boundary conditions for time-varying fields in the dielectric medium.

Phasors

Whenever a problem is time-harmonic the fields can be written in the form

n2 E1 E2–( )× 0=

n2 D1 D2–( )⋅ ρs=

n2 H1 H2–( )× Js=

n2 B1 B2–( )⋅ 0=

n2 J1 J2–( )⋅
ρs∂
t∂

--------–=

n– 2 E2× 0=

n– 2 H2× Js=

n– 2 D2⋅ ρs=

n– 2 B2⋅ 0=
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Instead of using a cosine function for the time dependence, it is more convenient to 
use an exponential function, by writing the field as

The field is a phasor, which contains amplitude and phase information of the field 
but is independent of t. One thing that makes the use of phasors suitable is that a time 
derivative corresponds to a multiplication by jω,

This means that an equation for the phasor can be derived from a time-dependent 
equation by replacing the time derivatives by a factor jω. All time-harmonic equations 
in the RF Module are expressed as equations for the phasors. (The tilde is dropped 
from the variable denoting the phasor.)

When postprocessing the solution of a time-harmonic equation, it is important to 
remember that the field that has been calculated is a phasor and not a physical field. 
For example, all plot functions visualize  by default, which is E at time t = 0. 
To obtain the solution at a given time, you can specify a phase factor in all 
postprocessing dialog boxes and in the corresponding functions. For more details 
about phase factors, see “The Phasor Variable” on page 177 in the COMSOL 
Multiphysics User’s Guide.

E r t,( ) E
ˆ

r( ) ωt φ+( )cos=

E r t,( ) E
ˆ

r( ) ωt φ+( )cos Re E
ˆ

r( )ejφejωt( ) Re E
˜

r( )ejωt( )= = =

E
˜

r( )

E∂
t∂

------- Re jωE
˜

r( )ejωt( )=

Re E
˜

r( )( )
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S p e c i a l  C a l c u l a t i o n s

S-Parameter Calculations

For high-frequency problems, voltage is not a well-defined entity, and it is necessary 
to define the scattering parameters (S-parameter) in terms of the electric field. To 
convert an electric field pattern on a port to a scalar complex number corresponding 
to the voltage in transmission line theory you need to perform an eigenmode 
expansion of the electromagnetic fields on the ports. Assume that you have performed 
eigenmode analyses on the ports 1, 2, 3,... and that you know the electric field patterns 
E1, E2, E3,… of the fundamental modes on these ports. Further, assume that the fields 
are normalized with respect to the integral of the power flow across each port cross 
section, respectively. Note that this normalization is frequency dependent unless you 
are dealing with TEM modes. The port excitation is applied using the fundamental 
eigenmode. The computed electric field Ec on the port consists of the excitation plus 
the reflected field. The S-parameters are given by

and so on. To get S22 and S12, excite port number 2 in the same way.

S - P A R A M E T E R S  I N  TE R M S  O F  P O W E R  F L O W

It is also possible to calculate the S-parameters from the power flow through the ports. 
Such a definition is only the absolute value of the S-parameters defined in the previous 
section and does not have any phase information. The advantage of using the power 

S11

Ec E1–( ) E1
*⋅( ) A1d

port 1
∫

E1 E1
*⋅( ) A1d

port 1
∫

----------------------------------------------------------------=

S21

Ec E2
*⋅( ) A2d

port 2
∫

E2 E2
*⋅( ) A2d

port 2
∫

-----------------------------------------------=

S31

Ec E3
*⋅( ) A3d

port 3
∫

E3 E3
*⋅( ) A3d

port 3
∫

-----------------------------------------------=
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flow to calculate the S-parameters is that you do not need to know the modes E1, E2, 
and E3. When the modes are degenerated, as is the case for circular ports, it is generally 
impossible to know the orientation of the wave. It is then impossible to find the correct 
superposition of the degenerated modes to match the calculated wave.

The definition of the S-parameters in terms of the power flow is

Both ways of normalizing the S-parameters are supported and the choice is made from 
the Port page in the Boundary Settings dialog box; see “The Coefficient Tab” on page 
57.

P O W E R  F L O W  N O R M A L I Z A T I O N

The fields E1, E2, E3, and so on, should be normalized such that they represent the 
same power flow through the respective ports. The power flow is given by the 
time-average Poynting vector,

The amount of power flowing out of a port is given by the normal component of the 
Poynting vector,

Below the cutoff frequency the power flow is zero, which implies that it is not possible 
to normalize the field with respect to the power flow below the cutoff frequency. But 
in this region the S-parameters are trivial and do not need to be calculated.

In the following subsections the power flow is expressed directly in terms of the electric 
field for TE, TM, and TEM waves.

TE Waves
For TE waves it holds that

S11
Power reflected from port 1

Power incident on port 1
-----------------------------------------------------------------------=

S21
Power delivered to port 2
Power incident on port 1
-----------------------------------------------------------------=

S31
Power delivered to port 3
Power incident on port 1
-----------------------------------------------------------------=

Sav
1
2
---Re E H*×( )=

n Sav⋅ n 1
2
---Re E H*×( )⋅=

E ZTE– n H×( )=
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where ZTE is the wave impedance

ω is the angular frequency of the wave, µ the permeability, and β the propagation 
constant. The power flow then becomes

TM Waves
For TM waves it holds that

where ZTM is the wave impedance

and ε is the permittivity. The power flow then becomes

TEM Waves
For TEM waves it holds that

where ZTEM is the wave impedance

The power flow then becomes

ZTE
ωµ
β

-------=

n Sav⋅ 1
2
---n Re E H*×( )⋅ 1

2
---Re E n H*×( )⋅( )–

1
2ZTE
-------------- E 2

= = =

H 1
ZTM
------------ n E×( )=

ZTM
β

ωε
-------=

n Sav⋅ 1
2
---n Re E H*×( )⋅ 1

2ZTM
--------------- n Re E n E*×( )×( )⋅( )= =

1
2ZTM
--------------- n E× 2

=

H 1
ZTEM
--------------- n E×( )=

ZTEM
µ
ε
---=

n Sav⋅ 1
2
---n Re E H*×( )⋅ 1

2ZTEM
------------------- n E× 2 1

2ZTEM
------------------- E 2

= = =
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where the last equality holds because the electric field is tangential to the port.

Lumped Port Parameters

In transmission line theory you deal with voltages and currents rather than electric and 
magnetic fields, so the lumped port provides an interface between them. The 
requirement on a lumped port is that the feed point must be similar to a transmission 
line feed, so its gap must be much less than the wavelength. It is then possible to define 
the electric field from the voltage as

where h is a line between the terminals at the beginning of the transmission line, and 
the integration is going from positive (phase) V to ground. The current is positive 
going into the terminal at positive V.

The transmission line current can be represented with a surface current at the lumped 
port boundary directed opposite to the electric field.

The impedance of a transmission line is defined as

and in analogy to this you can define a equivalent surface impedance at the lumped 
port boundary

To calculate the surface current density from the current we integrate along the width, 
w, of the transmission line

V E ld⋅
h
∫ E ah⋅( ) ld

h
∫= =

E
+V

I

Js h

Lumped port boundary

n

-V

Z V
I
----=

η
E ah⋅

Js ah–( )⋅
-------------------------=
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where the integration is taken in the direction of . This gives the following 
relation between the transmission line impedance and the surface impedance

where the last approximation assumed that the electric field is constant over the 
integrations. A similar relationship can be derived for coaxial cables

The transfer equations above is used in a slightly modified transition boundary 
condition.

where E is the total field and E0 the incident field, corresponding to the total voltage, 
V, and incident voltage, V0, at the port.

Far-Field Calculations

The far electromagnetic field from, for example, antennas can be calculated from the 
near field using the Stratton-Chu formula,

The antenna is located in the vicinity of the origin, while the far-field point p is taken 
at infinity but with a well-defined angular position . 

In the above formula,

• E and H are the fields on the “aperture”—the surface S enclosing the antenna.

I n J× s( ) ld⋅
w
∫ Js ah⋅( ) ld

w
∫–= =

ah n×

Z V
I
----

E ah⋅( ) ld
h
∫

Js ah⋅( ) ld
w
∫–

----------------------------------- η

E ah⋅( ) ld
h
∫

E ah⋅( ) ld
w
∫
------------------------------ η h

w
----≈= = = ⇒

η Zw
h
----=

η Z 2π
b
a
---ln

----------=

n H1 H2–( ) 1
η
---n E n×( )×+× 21

η
---n E0 n×( )×=

Ep
jk0
4π
--------r0 n E η0r0 n H×( )×–×[ ] jk0r r0⋅( )exp Sd∫×=

θ ϕ,( )
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• r0 is the unit vector pointing from the origin to the field point p. If the field points 
lie on a spherical surface S', r0 is the unit normal to S'.

• n is the unit normal to the surface S.

• η0 is the free-space impedance, . 

• k0 is the free-space wave number.

• r is the radius vector (not a unit vector) of the surface S.

• Ep is the calculated far field at point p.

The unit vector r0 can also be interpreted as the direction defined by the angular 
position , so Ep is the far field for this direction.

Because the far field is calculated in free space, the magnetic field at the far-field point 
is given by

The Poynting vector gives the power flow of the far field:

Thus the far-field radiation pattern is given by | Ep |2.

η0 µ0 ε0⁄=

θ ϕ,( )

Hp
r0 Ep×

η0
-------------------=

r0 S⋅ r0 Re Ep Hp
*×( ) Ep

2∼⋅=
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E l e c t r omagne t i c  Quan t i t i e s

The table below shows the symbol and SI unit for most of the physical quantities that 
appear in the RF Module. Although COMSOL Multiphysics supports other unit 
systems, the equations in the RF Module are written for SI units. The default values 
for the permittivity of vacuum, ε0 = 8.854187817·10−12 F/m, and for the 
permeability of vacuum, µ0 = 4π·10−7 H/m, require that you provide all other 
quantities in SI units and that you use meter for the length scale of the geometry. If 
you draw the geometry using another length scale, it becomes necessary to change the 
numerical values for the physical quantities accordingly. For example, if you draw the 
geometry using µm as the length scale, you need to have ε0 = 8.854187817·10−18 F/
µm and µ0 = 4π·10−13 H/µm.

TABLE 3-1:  ELECTROMAGNETIC QUANTITIES

QUANTITY SYMBOL UNIT ABBREVIATION

Angular frequency ω radian/second rad/s

Attenuation constant α meter-1 m-1

Capacitance C farad F

Charge q coulomb C

Charge density (surface) ρs coulomb/meter2 C/m2

Charge density (volume) ρ coulomb/meter3 C/m3

Current I ampere A

Current density (surface) Js ampere/meter A/m

Current density (volume) J ampere/meter2 A/m2

Electric displacement D coulomb/meter2 C/m2

Electric field E volt/meter V/m

Electric potential V volt V

Electric susceptibility χe (dimensionless) −

Electric conductivity σ siemens/meter S/m

Energy density W joule/meter3 J/m3

Force F newton N

Frequency ν hertz Hz

Impedance Z, η ohm Ω

Inductance L henry H
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Magnetic field H ampere/meter A/m

Magnetic flux Φ weber Wb

Magnetic flux density B tesla T

Magnetic potential (scalar) Vm ampere A

Magnetic potential (vector) A weber/meter Wb/m

Magnetic susceptibility χm (dimensionless) −

Magnetization M ampere/meter A/m

Permeability µ henry/meter H/m

Permittivity ε farad/meter F/m

Polarization P coulomb/meter2 C/m2

Poynting vector S watt/meter2 W/m2

Propagation constant β radian/meter rad/m

Reactance X ohm Ω

Relative permeability µr (dimensionless) −

Relative permittivity εr (dimensionless) −

Resistance R ohm Ω

Resistive loss Q watt/meter3 W/m3

Torque T newton-meter Nm

Velocity v meter/second m/s

Wavelength λ meter m

Wave number k radian/meter rad/m

TABLE 3-1:  ELECTROMAGNETIC QUANTITIES

QUANTITY SYMBOL UNIT ABBREVIATION
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 4
T h e  A p p l i c a t i o n  M o d e s
This chapter reviews the application modes in the RF Module. For each 
application mode, you find information about its applications, fundamental 
equations, available boundary conditions, and other related information.
 105
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Th e  App l i c a t i o n  Mode Fo rmu l a t i o n s

The application modes in the RF Module form a complete set of simulation tools for 
electromagnetic wave simulations. To select the right application mode for describing 
the real-life physics you need to consider the geometric properties and the time 
variations of the fields.

The application modes in the RF Module are listed below with the physical quantity 
solved for and the standard abbreviation that is used for the application modes in 
COMSOL Multiphysics. The physical quantities used are

• The electric field, E

• The magnetic field, H

• The magnetic potential, A

You can also use the application modes with COMSOL Script or MATLAB. See 
“Programming Reference” on page 29 in the RF Module Reference Guide for details.

Application Mode Guide

Table 4-1 on page 107 lists the available application modes in the RF Module. For a 
descriptive illustration and more details on each of these modes, see the corresponding 
section in the table’s Page column.

In the Name column you find the default name that is given to the application mode. 
This name appears as a label on the application mode when you use it and is of special 
importance when performing multiphysics simulations in order to distinguish between 
different application modes in the model. The variables defined by the application 
modes get an underscore plus the application mode name appended to their names.

The Dependent Variables column contains the variables that the PDEs are formulated 
for. For most 2D modes, the PDEs solved in the simulations are formulated for the 
components that are perpendicular to the modeling plane. For axisymmetric 
simulations, COMSOL Multiphysics makes a variable transformation to avoid 
singularities at the rotation axis.

The Field Components columns list the nonzero field components. In the application 
modes using Cartesian coordinates, the components are indexed by x, y, or z; for 
cylindrical coordinates, r, , or z are used.ϕ
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Finally, the Analysis Capabilities columns indicate the analysis types that the application 
mode supports.

TABLE 4-1:  RF MODULE APPLICATION MODES

APPLICATION MODE PAGE NAME DEP. VAR. FIELD 
COMPONENTS

ANALYSIS 
CAPABILITIES

M
A

G
N

E
T

IC
 F

IE
L

D

E
L

E
C

T
R

IC
 F

IE
L

D

T
R

A
N

S
IE

N
T

T
IM

E
-H

A
R

M
O

N
IC

E
IG

E
N

F
R

E
Q

U
E

N
C

Y
/E

IG
E

N
M

O
D

E

ELECTROMAGNETIC 
WAVES

111

3D Electromagnetic 
Waves

112 rfw E or H x y z x y z √ √ √

In-plane Waves, TE 
Modes

123 rfwe Ez x y z √ √ √

Axisymmetric 
Waves, TE Modes

132 rfwe r z √ √ √

In-Plane Waves, TM 
Modes

123 rfwh Hz z x y √ √ √

Axisymmetric 
Waves, TM Modes

132 rfwh r z √ √ √

In-Plane Waves, 
Hybrid Modes

123 rfweh Ez, Hz x y z x y z √ √ √

Axisymmetric 
Waves, Hybrid 
Modes

132 rfweh , r  
z

r  
z

√ √ √

Perpendicular 
Waves, TM Modes

138 rfwev Ez x y x y z √

Perpendicular 
Waves, TE Modes

138 rfwhv Hz x y z x y √

Perpendicular 
Waves, Hybrid 
Modes

138 rfwv Hx, Hy, 
or H, or 
Ex, Ey, 
or E

x y z x y z √

Eϕ r⁄ ϕ

Hϕ r⁄ ϕ

Eϕ r⁄
Hϕ r⁄

ϕ ϕ
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To carry out different kinds of simulations for a given set of parameters in an 
application mode, you only have to change the solver type  or specify the analysis type, 
which is an application mode property. The concept of application mode properties is 
introduced for setting up the coefficients in the underlying equations in a way that is 
consistent with the analysis carried out. The available analysis types are transient, 
harmonic, and eigenfrequency/eigenmode. Not all analysis types are available in all 
application modes.

You select the application mode from the Model Navigator when starting a new model. 
You can also add application modes to an existing model to create a multiphysics 
model.

3D Boundary Mode 
Analysis, TE Waves

147 rfwb Hn x y z x y z √

3D Boundary Mode 
Analysis, TM Waves

147 rfwb En x y z x y z √

3D Boundary Mode 
Analysis, 
Hybrid-Mode Waves

147 rfwb E, En 
or H, 
Hn

x y z x y z √

2D Boundary Mode 
Analysis, TE Waves

150 rfwb Hz  z x y √

2D Boundary Mode 
Analysis, TM Waves

150 rfwb Ez x y  z √

2D Boundary Mode 
Analysis, TE Waves, 
Axisymmetry

150 rfwb r z √

2D Boundary Mode 
Analysis, TM Waves, 
Axisymmetry

150 rfwb r z √

TABLE 4-1:  RF MODULE APPLICATION MODES

APPLICATION MODE PAGE NAME DEP. VAR. FIELD 
COMPONENTS

ANALYSIS 
CAPABILITIES

M
A

G
N

E
T

IC
 F

IE
L

D

E
L

E
C

T
R

IC
 F

IE
L

D

TR
A

N
S

IE
N

T

T
IM

E
-H

A
R

M
O

N
IC

E
IG

E
N

F
R

E
Q

U
E

N
C

Y
/E

IG
E

N
M

O
D

E

Eϕ r⁄ ϕ

Hϕ r⁄ ϕ
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When using the axisymmetric modes it is important to note that the horizontal axis 
represents the r direction and the vertical axis the z direction, and that you must create 
the geometry in the right half-plane, that is, for positive r only.

You specify all scalar properties that are specific to the application mode in the 
Application Scalar Variables dialog box. Their default values are either physical constants 
or arbitrary values in a value range that is commonly used for modeling, for example, 
the frequency 1 GHz for time-harmonic propagation.

Enter the application-specific domain properties in the Subdomain Settings dialog box. 
It is possible to define subdomain parameters for problems with regions of different 
material properties. Some of the domain parameters can either be a scalar or a matrix 
depending on if the material is isotropic or anisotropic.

The Boundary Settings dialog box also adapts to the current application mode and lets 
you select application-specific boundary conditions. A certain boundary type might 
require one or several fields to be specified, while others generate the boundary 
conditions without user-specified fields. 

The Edge Settings and Point Settings dialog boxes similarly let you specify 
application-specific conditions on edges and points.

Finally, use the Plot Parameters, Cross-Section Plot Parameters, and Domain Plot 

Parameters dialog boxes to visualize the relevant physical variables for all application 
modes in the model. The nonzero components of the electromagnetic vector fields 
contain the name of the coordinate, for example, Aphi is the component of the 
magnetic vector potential.

The remainder of this chapter contains all the details necessary to get full insight into 
the different application modes, that is, the physical assumptions and mathematical 
considerations they are based on, and all the functionality that is available. Each section 
describing a particular mode is divided into the following sections:

In the PDE Formulation section, the equation or equations that are solved in the 
application mode are derived.

In the Application Mode Properties section you find properties that are specific for the 
application mode. These properties can for example be used to select the analysis type.

The Application Scalar Variables section lists the parameters that are specific for the 
application mode. Their default values are either physical constants or arbitrary values 
in a value range that is commonly used for modeling, for example the frequency 1 GHz 
for harmonic propagation.

ϕ
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The Boundary and Interface Conditions section contains the available boundary 
conditions and explanations of their physical interpretation. 

In the Line Sources and Point Sources sections you find the available settings on edges 
and points, respectively.

Information about the Application Mode Variables can be found in Chapter 2, “The 
Application Modes,” of the RF Module Reference Guide. That section lists all 
variables that are available in postprocessing and when formulating the equations. You 
can use any function of these variables when postprocessing the result of the analysis. 
It is also possible to use these variables in the expressions for the physical properties in 
the equations.

M A T E R I A L  L I B R A R Y

All application modes in the RF Module support the use of the COMSOL 
Multiphysics material libraries. The electromagnetic material properties that you can 
store in the materials database are:

• The electric conductivity

• The relative permittivity

• The relative permeability

• The refractive index

See “Using the Materials/Coefficients Library” on page 223 in the COMSOL 
Multiphysics User’s Guide for details about the materials libraries.
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E l e c t r omagne t i c  Wav e s

Formulations for high-frequency waves can be derived from Maxwell-Ampère’s and 
Faraday’s laws,

Using the constitutive relations for linear materials D = ε Eand B = µ H as well as a 
current J = σ E, these two equations become

The relations  and  makes it possible to rewrite 
Maxwell-Ampère’s law using the magnetic potential.

Writing the fields on a time-harmonic form,

the two laws can be combined into either an equation for the electric field, or an 
equation for the magnetic field

where the second equation contains the complex permittivity,

∇ H× J D∂
t∂

-------+=

∇ E× B∂
t∂

-------–=

∇ H× σE εE∂
t∂

----------+=

∇ E× µ H∂
t∂

--------–=

µH ∇ A×= E
t∂

∂A
–=

µ0σ
t∂

∂A µ0 t∂
∂ ε

t∂
∂A ∇ µr

1– ∇ A×( )×+ + 0=

E x y z t, , ,( ) E x y z, ,( )ejωt
=

H x y z t, , ,( ) H x y z, ,( )ejωt
=

∇ µ 1– ∇ E×( )× ω2εcE– 0=

∇ εc
1– ∇ H×( )× ω2µH– 0=

εc ε jσ
ω
----–=
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The conductivity gives rise to ohmic losses in the medium. Other types of losses, for 
example polarization losses, are customarily given as an imaginary part of a complex 
permittivity,

where ε' is the real part of ε and all losses are given by ε''.

Alternatively, an equivalent conductivity can be defined representing all losses,

Refractive Index in Optics and Photonics

In optics and photonics applications, the refractive index is often used instead of the 
permittivity. In materials where µr is 1, the relation between the complex refractive 
index

and the complex relative permittivity is

that is

The inverse relations are

The parameter κ represents a damping of the electromagnetic wave.

3D Electromagnetic Waves Application Mode

In the 3D Electromagnetic Waves application mode, either of the two time-harmonic 
equations or the transient equation above can be solved. Both harmonic and transient 

εc ε' jε''–=

σ ωε''=

n n jκ–=

εrc n
2

=

ε'r n2 κ2
–=

ε''r 2nκ=

n2 1
2
--- ε'r ε'r

2 ε''r
2

++( )=

κ2 1
2
--- ε'r– ε'r

2 ε''r
2

++( )=
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propagation problems and eigenfrequency cavity problems can be handled. In 
harmonic propagation problems and in eigenfrequency cavity problems the application 
mode lets you solve for either for the electric field or the magnetic field. Solve for the 
field that is of most interest to you. In transient propagation problems you solve for 
the magnetic vector potential.

VE C T O R  E L E M E N T S

In 3D, Lagrange elements cannot be used for electromagnetic wave modeling. The 
reason is that they force the fields to be continuous everywhere. This implies that the 
interface conditions, which specify that the normal components of the electric and 
magnetic fields are discontinuous across interior boundaries between media with 
different permittivity and permeability, cannot be fulfilled. To overcome this problem, 
the 3D Electromagnetic waves application mode uses vector elements, which do not 
have this limitation.

The solution obtained when using vector elements also better fulfills the divergence 
conditions  and  than when using Lagrange elements.

P D E  F O R M U L A T I O N

The governing equations can be written in the form

for the time-harmonic and eigenfrequency problems and in the form

for transient problems with the constitutive relations B = µ0µr H + Br and 
D = ε0εr E + Dr. Other constitutive relations can also be handled for transient 
problems.

The wave number of free space k0 is defined as 

where c0 is the speed of light in vacuum.

∇ D⋅ 0= ∇ B⋅ 0=

∇ µr
1– ∇ E×( )× k0

2εrcE– 0=

∇ εrc
1– ∇ H×( )× k0

2µrH– 0=

µ0σ
t∂

∂A µ0ε0 t∂
∂ εr t∂

∂A Dr–⎝ ⎠
⎛ ⎞ ∇ µr

1– ∇ A Br–×( )×+ + 0=

k0 ω ε0µ0 ω c0⁄= =
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When solving the equations as an eigenfrequency problem the eigenvalue is the 
complex eigenfrequency λ = jω + δ, where δ is the damping of the solution. The 
Q-factor is given from the eigenvalue by the formula

Using the relation εr = n2, where n is the refractive index, the equations can 
alternatively be written

When the equation is written using the refractive index, the assumption is that µr = 1 
and σ = 0 and only the constitutive relations for linear materials are available. When 
solving for the scattered field the same equations are used but E = Esc + Ei and Esc is 
the dependent variable.

D I V E R G E N C E  C O N D I T I O N

Taking the divergence of the two equations above gives the electric and magnetic 
forms of Gauss’ law,

In the transient case and in most other cases it is sufficient that Gauss’ law is satisfied 
implicitly from the Helmholtz equation, which the application mode solves. When 
using periodic boundary conditions, however, you must add Gauss’ law explicitly as a 
separate equation to achieve numerical stability. To do this, set the Divergence condition 
property to On in the Application Mode Properties dialog box.

Qfact
ω

2 δ
---------=

∇ ∇ E×( )× k0
2n2E– 0=

∇ n 2– ∇ H×( )× k0
2H– 0=

µ0ε0 t∂
∂ n2

t∂
∂A

⎝ ⎠
⎛ ⎞ ∇ ∇ A×( )×+ 0=

∇ D⋅ 0=

∇ B⋅ 0=
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A P P L I C A T I O N  M O D E  P R O P E R T I E S

The application mode specific properties are given in the table below.

A P P L I C A T I O N  S C A L A R  V A R I A B L E S

The application-specific variables in this mode are given in the following table.

PROPERTY VALUES DESCRIPTION

Analysis type Harmonic propagation 
Eigenfrequency 
Transient

Specifies which type of 
analysis to perform.

Solve for Electric field 
Magnetic field 
Scattered electric field 
Scattered magnetic field

Specifies which field is the 
dependent variable.

Specify wave 
using

Frequency 
Free-space wavelength

Specifies if the frequency or 
the wavelength should be 
used as input.

Specify 
eigenvalues using

Eigenvalue 
Eigenfrequency

Specifies if the solver 
parameters should be given 
in terms of the eigenvalue 
λ = jω + δ or the 
eigenfrequency ν.

Divergence 
condition

On 
Off

Specifies if an explicit 
divergence condition 

 or  
should be added as a 
separate equation. Such a 
condition is necessary when 
using periodic boundary 
conditions.

PROPERTY NAME DEFAULT DESCRIPTION

µ0 mu0 4*pi*1e-7 Permeability of vacuum

ε0 epsilon0 8.854187817e-12 Permittivity of vacuum

ν nu 1e9 Frequency

λ0 lambda0 0.3 Free-space wavelength

E0ix E0ix 0 Incident electric field

E0iy E0iy 0 Incident electric field

E0iz E0iz exp(-j*k*x) Incident electric field

H0ix H0ix 0 Incident magnetic field

∇ D⋅ 0= ∇ B⋅ 0=
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All values are expressed in SI units. When solving the problem as a harmonic problem, 
you must specify the frequency ν or the free-space wavelength λ0. In the case of 
eigenfrequency simulations, the frequency is obtained from the solution of the 
problem. When solving for the scattered field the incident field needs to be specified 
to get correct equation and boundary conditions. When solving a harmonic problem 
for the total field, you can postprocess the scattered field if the incident field is given.

E I G E N F R E Q U E N C Y  C A L C U L A T I O N S

When making eigenfrequency calculations, there are a few important things to note:

• For the H-formulation it is possible to have a nonzero conductivity although it leads 
to nonlinear eigenvalue problems due to the complex permittivity εc = ε − jσ/ω 
Such problems have to be treated specially. Using a complex value for the relative 
permittivity does not create this problem, however.

• Nonlinear eigenvalue problems also appear for impedance boundary conditions 
with nonzero conductivity and for scattering boundary conditions adjacent to 
subdomains with nonzero conductivity.

• Some of the boundary conditions, such as the surface current condition and the 
electric field condition, allow you to specify a source in the eigenvalue problem. 
These conditions are available as a general tool to specify arbitrary expression 
between the H-field and the E-field. Avoid specifying solution independent sources 
for these conditions, since the eigenvalue solver ignores them anyway.

• Using the default parameters for the eigenfrequency solver, it may find a large 
number of false eigenfrequencies, which are almost zero. This is a known 
consequence of using vector elements. To avoid these eigenfrequencies, change the 
parameters for the eigenvalue solver in the Solver Parameters dialog box. Adjust the 
settings so that the solver searches for eigenvalues closer to the lowest 
eigenfrequency than to zero. Another way to avoid the false eigenfrequencies is to 
set the Divergence condition to On in the Application Mode Properties dialog box. 
Explicitly imposing that the divergence of D or B is zero removes most of the false 
eigenfrequencies.

For more information and an example, see “Lossy Eigenvalue Calculations” on page 
78.

H0iy H0iy 0 Incident magnetic field

H0iz H0iz exp(-j*k*x) Incident magnetic field

PROPERTY NAME DEFAULT DESCRIPTION
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B O U N D A R Y  A N D  I N T E R F A C E  C O N D I T I O N S

With no surface currents present the interface conditions

need to be fulfilled. Depending on which field you are solving for, it is necessary to 
analyze these conditions differently. When solving for E, the tangential component of 
the electric field is always continuous, and thus the first condition is automatically 
fulfilled. The second condition is equivalent to the natural boundary condition

and is therefore also fulfilled. When solving for H, the tangential component of the 
magnetic field is always continuous, and thus the second condition is automatically 
fulfilled. The first condition is equivalent to the natural boundary condition

and is therefore also fulfilled.When solving for A, the first condition can be formulated 
in the following way.

The tangential component of the magnetic vector potential is always continuous and 
thus the first condition is fulfilled. The second condition is equivalent to the natural 
boundary condition.

and is therefore also fulfilled.

Magnetic Field
The magnetic field boundary condition

specifies the tangential component of the magnetic field. When solving for the 
magnetic field, you can use this boundary condition at exterior and interior 

n2 E1 E2–( )× 0=

n2 H1 H2–( )× 0=

n µr
1– ∇ E×( )1 µr

1– ∇ E×( )2–[ ]×– n jωµ0 H1 H2–( )× 0= =

n εrc
1– ∇ H×( )1 εrc

1– ∇ H×( )2–[ ]×– n– jωε0 E1 E2–( )× 0= =

n2 E1 E2–( )× n2 t∂
∂A2

t∂
∂A1–

⎝ ⎠
⎜ ⎟
⎛ ⎞

×
t∂

∂ n2 A2 A1–( )×( )= =

n– µr
1– ∇ A1 µr

1– ∇ A2×–×( )× n– µr
1–× H1 H2–( ) 0= =

n H× n H0×=
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boundaries, but when solving for the electric field or the magnetic potential it is only 
applicable to exterior boundaries.

Surface Current
The surface current boundary condition

lets you specify a surface current density at both exterior and interior boundaries. The 
current density is specified as a three-dimensional vector, but because it needs to flow 
along the boundary surface, COMSOL Multiphysics projects it onto the boundary 
surface and neglects its normal component. This makes it easier to specify the current 
density and avoids unexpected results when a current density with a component 
normal to the surface is given.

When solving for the magnetic field, surface currents cannot be specified on interior 
boundaries.

Perfect Magnetic Conductor
The perfect magnetic conductor boundary condition

is a special case of the above conditions that sets the tangential component of the 
magnetic field to zero.

Electric Field
The electric field boundary condition

specifies the tangential component of the electric field. When solving for the electric 
field, this boundary condition is available at both exterior and interior boundaries, but 
when solving for the magnetic field it can only be applied to exterior boundaries. When 
solving for the magnetic potential this boundary condition is not available.

Perfect Electric Conductor
The perfect electric conductor boundary condition

n H×– Js=

n H1 H2–( )× Js=

n H× 0=

n E× n E0×=

n E× 0=
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is a special case of the above condition that sets the tangential component of the 
electric field to zero.

In the transient case this boundary condition sets the tangential component of the 
magnetic vector potential to zero. Because the perfect electric conductor boundary 
condition

implies that 

.

Normally the initial condition for A on a perfect electric conductor is zero. In the cases 
where the initial condition is different from zero, you can use the magnetic potential 
boundary condition.

Magnetic Potential
The magnetic potential boundary condition

makes it possible to set the tangential component of the magnetic vector potential. 
This can be used to give a tangential electric field by integrating the wanted value with 
respect to time. 

Scattering Boundary Condition
Use the scattering boundary condition when you want a boundary to be transparent 
for a scattered wave. The boundary condition is also transparent for an incoming plane 
wave. The wave types which the boundary condition can handle are

The field E0 is the incident plane wave which travels in the direction k. Note that the 
boundary condition is transparent for plane waves with any incidence angle. For the 
boundary to be perfectly transparent it is important that the boundary represent an 

n E× n
t∂

∂A×– 0= =

n A× A t 0=( )=

n A× n A0×=

E Esce
jk n r⋅( )–

E0e
jk k r⋅( )–

+= Plane scattered wave

E Esc
e

jk n r⋅( )–

r
------------------------ E0e

jk k r⋅( )–
+= Cylindrical scattered wave

E Esc
e

jk n r⋅( )–

rs
------------------------ E0e

jk k r⋅( )–
+= Spherical scattered wave
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open boundary. If the wave enters a guided structure where only certain modes can be 
present the boundary condition will give reflections. For such boundaries use the 
matched boundary condition.

For cylindrical waves you have to specify around which cylinder axis the waves are 
cylindrical. Do this by specifying one point at the cylinder axis and the axis direction.

For spherical wave you have to specify the center of the sphere around which the wave 
is spherical.

If the problem is solved for the eigenfrequency or the scattered field, the boundary 
condition does not include the incident wave.

Matched Boundary
The matched boundary condition can be used at boundaries which do not represent a 
physical boundary. If the boundary is a cross section of a waveguide and the wave is an 
eigenmode with propagation constant β of the waveguide, the matched boundary 
condition makes the boundary totally nonreflecting.

When the electric field E is the dependent variable, the matched boundary condition 
is perfectly transparent for TE and TEM modes. When the magnetic field H is the 
dependent variable the matched boundary condition is perfectly transparent for TM 
and TEM modes. If you want a matched boundary for a TM mode when solving for 
the electric field E, use the port boundary condition.

When E is the dependent variable the matched boundary condition reads

or

The source field, E0 or H0, represent an incident field.

When H is the dependent variable the matched boundary condition reads

Esc Esce
jk n r⋅( )–

= Plane scattered wave

Esc Esc
e

jk n r⋅( )–

r
------------------------= Cylindrical scattered wave

Esc Esc
e

jk n r⋅( )–

rs
------------------------= Spherical scattered wave

n ∇ E×( )× jβ E n E⋅( )n–( )– 2jβ E0 n E0⋅( )n–( )–=

n ∇ E×( )× jβ E n E⋅( )n–( )– 2jωµn H0×–=
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or

When solving for the eigenfrequency or the scattered wave the incident field is not 
included in the boundary condition:

or

Impedance Boundary Condition
The impedance boundary condition

is used at boundaries where the field is known to penetrate only a short distance 
outside the boundary. This penetration is approximated by a boundary condition to 
avoid the need to include another domain in the model. Although the equation is 
identical to the one in the low-reflecting boundary condition, it has a different 
interpretation. The material properties are for the domain outside the boundary and 
not inside, as for low-reflecting boundaries. A requirement for this boundary condition 
to be a valid approximation is that the magnitude of the complex reflective index

where µ1 and ε1 are the material properties of the inner domain, is large, that is 
| N | >> 1.

The source electric field Es can be used to specify a source surface current on the 
boundary.

Transition Boundary Condition
The transition boundary condition when the electric field is the dependent variable

n ∇ H×( )× jβ H n H⋅( )n–( )– 2jβ H0 n H0⋅( )n–( )–=

n ∇ H×( )× jβ H n H⋅( )n–( )– 2jωεn E0×=

n ∇ Esc×( )× jβ Esc n Esc⋅( )n–( )– 0=

n ∇ Hsc×( )× jβ Hsc n Hsc⋅( )n–( )– 0=

µ0µr

εc
------------n H E n E⋅( )n–+× n Es⋅( )n Es–=

N
µεc

µ1ε1
------------=

ηn H1 H2–( ) n E n×( )×–× n Es n×( )×=
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can be used on interior boundaries to model a thin sheet of a conducting or dielectric 
medium. The surface impedance η is a function of the material properties of the sheet 
and the thickness.

Similarly the transition boundary condition when the magnetic field is solved for

can be used on interior boundaries to model a thin sheet of a highly permeable 
medium.

Port
Use the port boundary condition for S-parameter calculations. This setting implies the 
same boundary condition as the matched boundary condition, but has additional 
functionality for generating the S-parameters. See the section “S-Parameters and 
Ports” on page 56 for more information.

Lumped Port
A lumped port is a simplification of the port boundary condition. Use it to apply a 
voltage signal between two conductors. It is based on a slightly modified transition 
boundary condition.

where the input electric field and surface impedance are calculated from the input 
voltage and characteristic impedance of the lumped port. They are both the result of 
an average over the lumped port boundaries, see “Lumped Ports with Voltage Input” 
on page 67 for more information how to use this condition.

Continuity
The continuity boundary condition

is the natural boundary condition ensuring continuity of the tangential components of 
the electric and magnetic fields.

Periodic Boundary Condition
The periodic boundary condition sets up a periodicity between the selected 
boundaries. See “Periodic Boundary Conditions” on page 26 for more details on this 
boundary condition.

n E1 E2–( ) ηn H n×( )×–× 0=

n H1 H2–( ) 1
η
---n E n×( )×+× 21

η
---n E0 n×( )×=

n H1 H2–( )× 0=

n E1 E2–( )× 0=
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E D G E  C O N D I T I O N S

When solving for the electric field, some conditions are available on edges.

Current
The current lets you specify a current I0 flowing along the edge. This current flows in 
the direction of the tangential vector of the edge. The easiest way to determine this 
direction is to make an arrow plot on the edges of a vector with the components t1x, 
t1y, and t1z.

Perfect Electric Conductor
The perfect electric conductor edge condition

sets the tangential component of the electric field to zero.

Magnetic Current
The magnetic current condition lets you specify a magnetic current Im0 flowing along 
the edge. This current flows in the direction of the tangential vector of the edge. The 
easiest way to determine this direction is to make an arrow plot on the edges of a vector 
with the components t1x, t1y, t1z. The condition is only available for the 
H-formulation.

A P P L I C A T I O N  M O D E  V A R I A B L E S

See the section “3D Electromagnetic Waves Application Mode” on page 14 of the 
RF Module Reference Guide.

In-Plane Waves Application Mode

The In-plane Waves application mode covers a situation where there is no variation in 
the z direction, and the electromagnetic field propagates in the modeling xy-plane. 
The application mode handles

• Transverse electric (TE) waves, 

• Transverse magnetic (TM) waves,

• Hybrid-mode waves. A hybrid-mode wave is a linear combination of a TE wave and 
a TM wave. Working with hybrid-mode waves allows for specifying elliptical or 
circular waves as incoming waves.

t E⋅ 0=
E L E C T R O M A G N E T I C  W A V E S  |  123



124 |  C H A P T E R
P D E  F O R M U L A T I O N  F O R  T E  WAV E S

As the field propagates in the modeling xy-plane a TE wave has only one electric field 
component in the z direction, and the magnetic field lies in the modeling plane. Thus 
the transient and time-harmonic fields can be written

To be able to write the fields in this form, it is also required that εr, σ, and µr are 
nondiagonal only in the xy-plane. µr denotes a 2-by-2 tensor, and εrzz and σzz are the 
relative permittivity and conductivity in the z direction.

Given the above constraints, the equation

where

can be simplified to a scalar equation for Ez,

where

Using the relation εr = n2, where n is the refractive index, the equation can 
alternatively be written

When the equation is written using the refractive index, the assumption is that µr = 1 
and σ = 0.

The wave number in vacuum k0 is defined by

E x y t, ,( ) Ez x y t, ,( ) Ez x y,( )ezejωt
= =

H x y t, ,( ) Hx x y t, ,( )ex Hy x y t, ,( )ey+ Hx x y,( )ex Hy x y,( )ey+( )ejωt
= =

∇ µr
1– ∇ E×( )× k0

2εrcE– 0=

εrc εr j σ
ωε0
---------–=

∇ µ̃r Ez∇( ) εrczzk0
2

– Ez⋅– 0=

µ̃r
µr

T

det µr( )
-------------------=

∇ Ez∇ nzz
2 k0

2
– Ez⋅– 0=

k0 ω ε0µ0 ω c0⁄= =
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where c0 is the speed of light in vacuum.

The equation in the time domain

 (4-1)

can be simplified to a scalar equation for Az:

Here the constitutive relations used are B = µ0µr H + Br and D = ε0εr E + Dr. Other 
constitutive relations can also be handled for transient problems.

Using the relation εr = n2, where n is the refractive index, the equation can 
alternatively be written

When using the refractive index, the assumption is that µr = 1 and σ = 0 and only the 
constitutive relations for linear materials can be used.

P D E  F O R M U L A T I O N  F O R  T M  WAV E S

TM waves has a magnetic field with only a z component and an electric field in the 
xy-plane. Thus the fields can be written as

To write the fields in this form, it is also required that µr and εr are nondiagonal only 
in the xy-plane. εr and σ denote 2-by-2 tensors, and µrzz is the relative permeability in 
the z direction.

Given the above constraints the time-harmonic equation

can be simplified to a scalar equation for Hz,

µ0σ
t∂

∂A µ0ε0 t∂
∂ εr t∂

∂A Dr–⎝ ⎠
⎛ ⎞ ∇ µr

1– ∇ A Br–×( )( )×+ + 0=

µ0σ
t∂

∂Az µ0ε0 t∂
∂ εr t∂

∂Az Drz–⎝ ⎠
⎛ ⎞ ∇ µr

1– ∇Az Br–( )( )⋅+ + 0=

µ0ε0 t∂
∂ n2

t∂
∂Az

⎝ ⎠
⎛ ⎞ ∇ ∇Az Br–( )⋅+ 0=

H x y t, ,( ) Hz x y t, ,( ) H= z x y,( )ezejωt
=

E x y t, ,( ) Ex x y t, ,( )ex Ey x y t, ,( )ey+ Ex x y,( )ex Ey x y,( )ey+( )ejωt
= =

∇ εrc
1– ∇ H×( )× k0

2µrH– 0=

∇ ε̃rc Hz∇( ) µrzzk0
2Hz–⋅– 0=
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where

Using the relation εr = n2, where n is the refractive index, the equation can 
alternatively be written

In the time-domain the equation for TM waves equation is simplified to

Here the constitutive relations B = µ0µr H + Br and D = ε0εr E + Dr and  are used 
Other constitutive relations can also be handled by the application mode.

Using the relation εr = n2, where n is the refractive index, the equation can 
alternatively be written

In this case only the constitutive relations for linear materials can be used.

P D E  F O R M U L A T I O N  F O R  H Y B R I D - M O D E  WA V E S

Hybrid-mode waves are handled simply by solving the two equations for TE and TM 
waves together. As these two equation do not couple, they can be solved in sequence.

VE C T O R  E L E M E N T S

For TM waves in the time-domain, Lagrange elements cannot be used. The reason is 
that they force the fields to be continuous everywhere. This implies that the interface 
conditions, which specify that the normal components of the electric and magnetic 
fields are discontinuous across interior boundaries between media with different 
permittivity and permeability, cannot be fulfilled. This is only a problem when solving 
for the components in the plane. To overcome this problem, the transient TM waves 
application mode uses vector elements, which do not have this limitation.

ε̃rc
εrc

T

det εrc( )
--------------------=

∇ ñ
2

Hz∇( ) k0
2Hz–⋅– 0=

µ0σ
t∂

∂A µ0ε0 t∂
∂ εr t∂

∂A Dr–⎝ ⎠
⎛ ⎞ ∇ µr

1– ∇ A Brz–×( )( )×+ + 0=

µ0ε0 t∂
∂ n2

t∂
∂A

⎝ ⎠
⎛ ⎞ ∇ ∇ A×( )×+ 0=
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A P P L I C A T I O N  M O D E  P R O P E R T I E S

The application mode specific properties are given in the table below.

A P P L I C A T I O N  S C A L A R  V A R I A B L E S

The application-specific variables in this mode are given in the following table.

All values are expressed in SI units. When solving the problem as a harmonic problem, 
the frequency ν or the free-space wavelength λ0 needs to be specified. In the case of 
eigenfrequency simulations, the frequency is obtained from the solution of the 
problem.

B O U N D A R Y  A N D  I N T E R F A C E  C O N D I T I O N S

With no surface currents present the interface conditions

need to be fulfilled. 

PROPERTY VALUES DESCRIPTION

Analysis type Harmonic propagation 
Eigenfrequency 
Transient

Specifies which type of 
analysis to perform.

Field type TE waves 
TM waves 
Hybrid-mode waves

Specifies which type of 
waves to handle.

Specify wave 
using

Frequency 
Free space wavelength

Specifies if the frequency or 
the wavelength should be 
used as input.

Specify 
eigenvalues using

Eigenvalue 
Eigenfrequency

Specifies if the solver 
parameters should be given 
in terms of the eigenvalue 

 or the 
eigenfrequency ν.

PROPERTY NAME DEFAULT DESCRIPTION

µ0 mu0 4*pi*1e-7 Permeability of vacuum

ε0 epsilon0 8.854187817e-12 Permittivity of vacuum

ν nu 1e9 Frequency

λ0 lambda0 0.3 Free space wavelength

λ k0
2

=

n2 E1 E2–( )× 0=

n2 H1 H2–( )× 0=
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When solving for the electric field, Ez is always continuous, and thus the first condition 
is automatically fulfilled. The second condition is equivalent to the natural boundary 
condition

and is therefore also fulfilled. When solving for the magnetic field, Hz is always 
continuous, and thus the second condition is automatically fulfilled. The first 
condition is equivalent to the natural boundary condition

and is therefore also fulfilled. When solving the transient equation, the first condition 
can be formulated in the following way.

The tangential component of the magnetic vector potential is always continuous and 
thus the first condition is fulfilled. The second condition is equivalent to the natural 
boundary condition.

and is therefore also fulfilled.

Magnetic Field
The magnetic field boundary condition

specifies the magnetic field at the boundary. For TM waves the magnetic field can also 
be specified at interior boundaries.

Surface Current
The surface current boundary condition

specifies a surface current flowing in the z direction.

n µ̃r Ez∇( )ez⋅ n µr
1– ∇ E×( )×– n jωµ0H( )×= =

n ε̃rc Hz∇( )ez⋅ n εrc
1– ∇ H×( )×– n jωε0E( )×–= =

n2 E1 E2–( )× n2 t∂
∂A2

t∂
∂A1–

⎝ ⎠
⎜ ⎟
⎛ ⎞

×
t∂

∂ n2 A2 A1–( )×( )= =

n– µr
1– ∇ A1 µr

1– ∇ A2×–×( )× n– µr
1–× H1 H2–( ) 0= =

n H× n H0×=

n H×– Jszez=

n H1 H2–( )× Jszez=
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Perfect Magnetic Conductor
The perfect magnetic conductor boundary condition

sets the magnetic field to zero at a boundary. For TM waves the boundary condition 
can also be used at interior boundaries.

Electric Field
The electric field boundary condition

specifies the electric field at an outer boundary. For time-harmonic TE waves the 
electric field can also be specified at interior boundaries.

Perfect Electric Conductor
The perfect electric conductor boundary condition

sets the electric field to zero at the boundary. For TE waves the boundary condition 
can also be used at interior boundaries.

In the transient case this boundary condition is used to set the tangential component 
of the magnetic vector potential to zero. Since the perfect electric conductor boundary 
condition

implies that 

.

Normally the initial condition for A on a perfect electric conductor is zero. In the cases 
where the initial condition is different from zero the magnetic potential boundary 
condition can be used.

Electric and Magnetic Field
The electric and magnetic field boundary condition

n H× 0=

n E× n E0×=

n E× 0=

n E× n
t∂

∂A×– 0= =

n A× A t 0=( )=

Ez E0z= Hz H0z=
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can be used for hybrid-mode waves to specify the z component of the electric and 
magnetic fields at interior boundaries.

Magnetic Potential
The magnetic potential boundary condition

specifies the magnetic vector potential. This boundary condition can be used to specify 
the electric field in a transient problem by integrating the electric field with respect to 
t and entering it as a potential.

Scattering Boundary Condition
Use the scattering boundary condition when you want a boundary to be transparent 
for a scattered wave. The boundary condition is also transparent for an incoming plane 
wave. The wave types which the boundary condition can handle are

The field E0 is the incident plane wave which travels in the direction k. Note that the 
boundary condition is transparent for plane waves with any incidence angle. For the 
boundary to be perfectly transparent it is important that the boundary represent an 
open boundary. If the wave enters a guided structure where only certain modes can be 
present, the boundary condition gives reflections. For such boundaries use the 
matched boundary condition.

For cylindrical waves you have to specify around which point  the waves 
are cylindrical. The radius . 

Matched Boundary
The matched boundary condition

is mainly intended to be used at boundaries that do not represent a physical boundary. 
If the electric field is an eigenmode of the boundary, and if β is the propagation 
constant of the wave, the boundary is exactly nonreflecting.

n A× n A0×=

E Esce
jk n r⋅( )–

E0e
jk k r⋅( )–

+= Plane scattered wave

E Esc
e

jk n r⋅( )–

r
------------------------ E0e

jk k r⋅( )–
+= Cylindrical scattered wave

r0 x0 y0,( )=

r x x0–( )2 y y0–( )2
+=

ez n ∇ Ezez×( )× jβEz–⋅ 2jβE0z–= (TE waves)

ez n ∇ Hzez×( )× jβHz–⋅ 2jβH0z–= (TM waves)
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Impedance Boundary Condition
The impedance boundary condition

is used at boundaries where the field is known to penetrate only a short distance 
outside the boundary. This penetration is approximated by a boundary condition to 
avoid the need to include another domain in the model.

The source electric field Esz can be used to specify a surface current on the boundary.

Transition Boundary Condition
The transition boundary condition

can be used at interior boundaries to model a thin conductive or dielectric sheet. The 
surface impedance η is a function of the material properties and thickness of the sheet.

Lumped Port
A lumped port is a simplification of the port boundary condition. Use it to apply a 
voltage signal between two conductors. It is based on a slightly modified transition 
boundary condition.

where the input electric field and surface impedance are calculated from the input 
voltage and characteristic impedance of the lumped port. They are both the result of 
an average over the lumped port boundaries, see “Lumped Ports with Voltage Input” 
on page 67 for more information how to use this condition. It is only available for the 
transient TM waves and transient hybrid-mode waves.

Neutral
The neutral boundary condition

n H×
ε0εrc

µ0µr
-------------Ezez+

ε0εrc

µ0µr
-------------Eszez= (TE waves)

n E×–
µ0µr

ε0εrc
-------------Hzez+ 0= (TM waves)

ηn H1 H2–( )× Ezez+ Eszez–=

n E1 E2–( )× 0=

n H1 H2–( ) 1
η
---n E n×( )×+× 21

η
---n E0 n×( )×=

ez n E×( )⋅ 0= ez n H×( )⋅ 0=
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is available only for hybrid-mode waves. It should be used at boundaries where 
periodic boundary conditions are applied to obtain a Neumann boundary condition 
for both dependent variables, Ez and Hz.

Continuity
The continuity boundary condition

is the natural boundary condition enforcing continuity of the tangential components 
of the electric and magnetic fields.

Periodic Boundary Condition
The periodic boundary condition sets up a periodicity between the selected 
boundaries. See “Periodic Boundary Conditions” on page 26 for more details on this 
boundary condition.

P O I N T  S O U R C E S

When working with TE waves, you can specify a current I0 to flow in the z direction 
at points in the geometry. For TM waves it is possible to specify a magnetic current Im0 
flowing out of the plane.

A P P L I C A T I O N  M O D E  V A R I A B L E S

See the section “In-Plane Waves Application Mode” on page 15 of the RF Module 
Reference Guide.

Axisymmetric Waves Application Mode

Use the Axisymmetric Waves application mode in situations where you have axial 
symmetry and thus no variation in the direction. The application mode handles:

• Transverse electric (TE) waves, 

• Transverse magnetic (TM) waves, 

• Hybrid-mode waves. A hybrid-mode wave is a linear combination of a TE wave and 
a TM wave. Working with hybrid-mode waves allows for specifying elliptical or 
circular waves as incoming waves.

n H1 H2–( )× 0=

n E1 E2–( )× 0=

ϕ
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P D E  F O R M U L A T I O N  F O R  T E  WA V E S

A TE wave has only one electric field component in the  direction, and the magnetic 
field lies in the modeling plane. Thus the fields can be written

To write the fields in this form, it is also required that εr and µr are nondiagonal only 
in the rz-plane. µr denotes a 2-by-2 tensor, and  and are the relative 
permittivity and conductivity in the direction.

Given the above constraints, the equation

can be simplified to a scalar equation for ,

where

and where the wave number in vacuum is 

Using the relation εr = n2, where n is the refractive index, the equation can 
alternatively be written

The assumption when using the refractive index is that µr = 1 and σ = 0.

ϕ

E r z t, ,( ) Eϕ r z t, ,( ) Eϕ r z,( )eϕejωt
= =

H r z t, ,( ) Hr r z t, ,( )er Hz r z t, ,( )ez+ Hr r z,( )er Hz r z,( )ez+( )ejωt
= =

εrϕϕ σϕϕ
ϕ

∇ µr
1– ∇ E×( )× k0

2εrcE– 0=

Eϕ

r∂
∂

z∂
∂– µ̃r

1
r
---

r∂
∂ rEϕ( )

z∂
∂Eϕ

⎝ ⎠
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎛ ⎞

⋅ εrcϕϕk0
2Eϕ– 0=

µ̃r
µr

T

det µr( )
-------------------=

k0 ω ε0µ0 ω c0⁄= =

r∂
∂

z∂
∂–

1
r
---

r∂
∂ rEϕ( )

z∂
∂Eϕ

⋅ nϕϕ
2 k0

2Eϕ– 0=
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The transient equation

can for TE waves be written

using the constitutive relations B = µ0µr H + Br and D = ε0εr E + Dr. When using the 
relation εr = n2, where n is the refractive index, the equation can be formulated the 
following way

In this case the application mode only handles the constitutive relations for linear 
materials.

Because there are coefficients where a division by r occurs, the PDE is not properly 
defined close to the z axis. A variable transformation avoids this problem:

 or 

The resulting equations become

for either a harmonic problem or an eigenvalue problem with the eigenvalue , 
and

µ0σ
t∂

∂A µ0ε0 t∂
∂ εr t∂

∂A Dr–⎝ ⎠
⎛ ⎞ ∇ µr

1– ∇ A Br–×( )( )×+ + 0=

µ0σ
t∂
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=
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for a transient problem.

P D E  F O R M U L A T I O N  F O R  T M  WAV E S

TM waves has a magnetic field with only a component and an electric field in the 
rz-plane. Thus the fields can be written

To write the fields in this form it is also required that µr and εr are nondiagonal only 
in the rz-plane. εr and σ denote 2-by-2 tensors, and is the relative permeability 
is the direction.

Given the above constraints, the equation

can be simplified to a scalar equation for ,

where

Using the relation εr = n2, where n is the refractive index, the equation can 
alternatively be written

µ0σ
t∂

∂Aϕ µ0ε0 t∂
∂ εr t∂

∂Aϕ Drϕ–⎝ ⎠
⎛ ⎞

r∂
∂

z∂
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r

r∂
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r
z∂

∂u Brr+

⋅–+ 0=

ϕ

H r z t, ,( ) Hϕ r z t, ,( ) H= ϕ r z,( )eϕejωt
=

E r z t, ,( ) Er r z t, ,( )er Ez r z t, ,( )ez+ Er r z,( )er Ez r z,( )ez+( )ejωt
= =

µrϕϕ
ϕ

∇ εrc
1– ∇ H×( )× k0

2µrH– 0=

Hϕ

r∂
∂

z∂
∂– ε̃rc

1
r
---

r∂
∂ rHϕ( )

z∂
∂Hϕ

⎝ ⎠
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎛ ⎞

⋅ µrϕϕk0
2Hϕ– 0=
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T
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To avoid singularities at the axis of rotation, introduce the dependent variable u, which 
is defined as the angular component of the magnetic field divided by the radial space 
coordinate r, that is,

Transforming the equation above using this variable gives the equation

which can be solved either as a stationary problem or as an eigenvalue problem with 
the eigenvalue . 

The transient equation for TM waves can be written

using the constitutive relations B = µ0µr H + Br and D = ε0εr E + Dr. Other 
constitutive relations can also be handled for transient problems. When using the 
relations, n2 = εr, µr = 1 and σ = 0 the equation becomes

Wen giving the refractive index, the formulation only handles constitutive relations for 
linear materials.

P D E  F O R M U L A T I O N  F O R  H Y B R I D - M O D E  WA V E S

Hybrid-mode waves are handled simply by solving the two equations for TE and TM 
waves together. Because the two equation do not couple, it is possible to solve them 
in sequence.
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z∂
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∂
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⎛ ⎞
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A P P L I C A T I O N  M O D E  P R O P E R T I E S

See the corresponding section for In-Plane Waves on page 127.

A P P L I C A T I O N  S C A L A R  V A R I A B L E S

See the corresponding section for In-Plane Waves on page 127.

B O U N D A R Y  A N D  I N T E R F A C E  C O N D I T I O N S

For a thorough discussion about the different boundary conditions, see “Boundary 
and Interface Conditions” on page 127 for the in-plane case. This section only covers 
the differences from the in-plane case.

Scattering Boundary Condition
In the axisymmetric case the scattering boundary condition can handle:

The cylindrical waves are cylindrical with respect to the z axis and the spherical waves 
have to be spherical around the origin. The spherical radius . 

Axial Symmetry
You must use the axial symmetry boundary condition along the z-axis, because at the 
symmetry axis, the meridional fields must satisfy the conditions

The relative permeability must also be scalar along the symmetry axis for the same 
conditions to be fulfilled for the magnetic flux density B.

In the time-harmonic case these conditions are equivalent to the following conditions 
on the dependent variable u.

E Esc
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The first condition is obviously always fulfilled, while the second one is fulfilled when 
r is zero, if and only if

In the transient case using the variable u, the first of the above equations is 
automatically fulfilled whenever r is zero, which is shown by the identity

The second symmetry condition must be given explicitly. Writing the expression using 
the dependent variable, u, the equation for the symmetry condition becomes

This is zero when r is zero if and only if

This derivation holds for TE waves. For TM waves a corresponding boundary 
condition can be derived using the requirements that

at the symmetry axis.

A P P L I C A T I O N  M O D E  V A R I A B L E S

See the section “Axisymmetric Waves Application Mode” on page 17 of the RF 
Module Reference Guide.

Perpendicular Waves Application Mode

In the application mode describing perpendicular electromagnetic waves, 3D waves 
that can be described as

u∂
r∂

------ 0=
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are handled. The constant β in the exponential is the propagation constant. In those 
cases where β is a complex number, you can define the attenuation constant 
α = −Im(β), which expresses how the wave decreases, . 

Various formulations derived from Maxwell-Ampère’s and Faraday’s laws

are used in the perpendicular electromagnetic waves application mode.

Two general classes of problems are treated, one where λ = −δz − jβ is calculated as the 
eigenvalue, and one where the angular frequency ω is found from the eigenvalue 
λ = −δ − jω. The derivation in the following section assumes that the eigenvalue is a 
complex number with the real part equal to zero, λ = −jβ and λ = −jω. All occurrences 
of jβ or −β2 can be replaced with δ + jβ or (δ + jβ)2, and you can do the same 
replacement for jω. This is only a simplification to make the expressions easier to read.

PE R P E N D I C U L A R  T M  WAV E S

Treating perpendicular TM waves introduces the restriction that the medium is 
homogeneous, that is, µ and ε are constant. In such a homogeneous medium where 
the magnetic field is transversal, that is, the z component vanishes, a scalar 
second-order PDE can be formulated for Ez.

P D E  F O R M U L A T I O N  F O R  T M  WAV E S

Given that µ and ε are constant, and Hz = 0, Maxwell-Ampère’s and Faraday’s laws give

By combining these equations, the following equation for Ez can be derived

E x y z t, , ,( ) E
ˆ

x y,( )ej ωt βz–( )
=

H x y z t, , ,( ) H
ˆ

x y,( )ej ωt βz–( )
=

e αz–

∇ H× jωεE=

∇ E× jωµH–=

y∂
∂Ez jβEy+ jωµHx–=

x∂
∂Ez jβEx+ jωµHy=

jβHy jωεcEx=

jβHx jωεcEy–=

x∂
∂Hy

y∂
∂Hx– jωεcEz=
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where both εrc and µr are scalar constants. The wave number in vacuum is here defined 
by

Using the relation εr = n2, where n is the refractive index, the equation can 
alternatively be written

When using the refractive index the assumption is that µr = 1 and σ = 0.

P E R P E N D I C U L A R  T E  WA V E S

As in the TM case, perpendicular TE waves requires that the medium is homogeneous, 
that is, µ and ε are constant. In such a homogeneous medium where the electric field 
is transversal, that is, the z component vanishes, a scalar second order PDE can be 
formulated for Hz.

P D E  F O R M U L A T I O N  F O R  T E  WAV E S

Given that µ and ε are constant, and Ez = 0, Maxwell-Ampère’s and Faraday’s laws give

By combining these equations, the following equation for Hz can be derived

,

Both the permeability and the permittivity are scalar constants. Using the relation 
εr = n2, where n is the refractive index, the equation can alternatively be written

∇ µr
1– Ez∇( ) εrck0

2Ez–⋅– β–
2µr

1– Ez=

k0 ω ε0µ0 ω c0⁄= =
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jβEy jωµHx–=

jβEx jωµHy=

x∂
∂Ey
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x∂
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∇ εrc
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2εrc

1– Hz=
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P E R P E N D I C U L A R  H Y B R I D - M O D E  WAV E S

Perpendicular hybrid-mode waves treats the case of transversal fields and 
inhomogeneous materials. In this case there are two possible formulations available. 
Either two equations for the two transversal field components are solved, or a set of 
three equations for all three fields components.

P D E  F O R M U L A T I O N  F O R  H Y B R I D - M O D E  WAV E S

Consider anisotropic complex relative permittivity and relative permeability of the 
form

Three-Component Formulation
This derivation is made for the electric field, but the derivation for the magnetic field 
is almost identical. The starting point is the equation

Multiplying with jωµ0 and converting into the weak form results in an integral 
expression

where denotes the vector-valued test function. For electric fields of the form

a straightforward calculation gives
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where α is the complex valued propagation constant, usually equal to the pure 
imaginary propagation constant jβ. The following variable declarations are necessary 
to simplify the expressions:

Two types of eigenvalues can be used, λ = −δz − jβ and λ = −δ − jωβ. For simplicity, the 
previous derivation only included the imaginary part jω. For damped eigenvalue 
problems the eigenvalue becomes complex, and the real parts δz and δ become 
nonzero. These terms are available as the variables dampz and damp, respectively.

Two-Component Formulation
In the following, let εrct and µrt denote the 2-by-2 tensors in the transversal xy-plane,

It is possible to reduce the set of three equations to two equations for the transversal 
components of the magnetic field Ht. To do this, use that , which for the 
magnetic field becomes

Substituting this into the equation

gives

µ0 jωJT E
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----------------------------------------= =

∇ E
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T× αaz E
˜

T× az az ∇ E
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T×( )⋅( )+ curlE
˜

T azcurlE
˜

Tz+= =

∇ az α–( ) ẽz× curlE
˜

zT=
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εrcxx εrcxy

εrcyx εrcyy

= µrt
µrxx µrxy

µryx µryy

=

∇ B⋅ 0=

∇t µrtHt jβµrzzHz–⋅ 0=

∇t εrczz
1– ∇t Ht×( ) jβε̃rct∇tHz– k0

2µrt β2ε̃rct–( )Ht–× 0=
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You can solve this equation as an eigenvalue problem both for λ = −jβ and λ = −jω.

Electric Field Formulations
To obtain the corresponding formulations for the electric field from the equations 
above, replace H by E and interchange εc and µ.

A P P L I C A T I O N  M O D E  P R O P E R T I E S

The following table lists the properties for this application mode:

PROPERTY VALUES DESCRIPTION

Analysis type Harmonic propagation 
Eigenfrequency

Specifies which type of 
analysis to perform.

Field type TE waves 
TM waves 
Hybrid-mode waves

Specifies which type of 
waves to handle.

Specify wave 
using

Frequency 
Free-space wavelength

Specifies if the frequency or 
the wavelength should be 
used as input.

Solve for Electric field 
Magnetic field

Specifies which field is the 
dependent variable.

Field 
components

In-plane components 
All three components

Specifies if the two or 
three-component 
formulation is used for 
hybrid-mode waves.

Specify 
eigenvalues using

Eigenvalue 
Eigenfrequency 
Propagation constant 
Effective mode index

Specifies if the solver 
parameters should be given 
in terms of the eigenvalue or 
some other quantity. When 
doing mode analysis, the 
effective mode index or the 
propagation constant can be 
used. When doing 
eigenfrequency analysis, the 
eigenfrequency can be used.

∇t εrczz
1– ∇t Ht×( )× ε̃rct∇t µrzz

1– ∇t µrtHt⋅( )– k0
2µrt β2ε̃rt–( )Ht– 0=
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A P P L I C A T I O N  S C A L A R  V A R I A B L E S

The following table lists the application-specific variables in this application mode:

The constants ε0 and µ0 are expressed in SI units. When solving the problem as an 
eigenvalue problem for β, you must specify the frequency ν or the free-space 
wavelength λ0, and β is obtained from the solution. When solving the problem as an 
eigenvalue problem for ν, you must specify the propagation constant β. In this case, ν 
is obtained from the solution.

B O U N D A R Y  A N D  I N T E R F A C E  C O N D I T I O N S

With no surface currents present, the interface conditions

must be fulfilled. Depending on which formulation you use, it is necessary to analyze 
these conditions differently.

For TE and TM waves it can be shown that they are not fulfilled at interfaces between 
different media, hence these formulation only handles homogeneous media.

For hybrid-mode waves the following section covers the cases where you solve for the 
magnetic field. The cases where you solve for the electric field can be analyzed 
analogously.

Three-Component Formulation
When the three-component formulation is used, the condition

PROPERTY NAME DEFAULT UNIT DESCRIPTION

µ0 mu0 4*pi*1e-7 H/m Permeability of vacuum

ε0 epsilon0 8.854187817e-12 F/m Permittivity of vacuum

ν nu 1e9 Hz Frequency

λ0 lambda0 0.3 m Free-space wavelength

β beta 30 - Propagation constant

n2 E1 E2–( )× 0=

n2 H1 H2–( )× 0=

n2 ε1E1 ε2E2–( )⋅ 0=

n2 µ1H1 µ2H2–( )⋅ 0=

n2 E1 E2–( )× 0=
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is the natural boundary condition, which comes from the equation. This can most 
easily be seen from the equation used to derive the formulation from,

It leads to the natural boundary condition

Nothing in the formulation explicitly constrains the normal component of E. The 
condition

falls out as a part of the solution.

The conditions for the magnetic field require that Hz as well as the tangential 
component of Ht are continuous across interior boundaries. On the other hand the 
normal component of Ht must be allowed to be discontinuous if µ is discontinuous 
across the interior boundary. These conditions are fulfilled by using vector elements 
for Ht and Lagrange elements for Hz. Vector elements for Ht are the best choice also 
when µ does not vary, because unlike the Lagrange elements, they do not give rise to 
spurious modes.

Two-Component Formulation
The two-component formulation also has the requirement that the tangential 
component of Ht is continuous across interior boundaries. The normal component of 
Ht is allowed to be discontinuous if µ is discontinuous across the interior boundary. It 
is not possible to use vector elements for Ht in the two-component formulation, 
however, because vector elements cannot be used when the equation contains a 
divergence term. This limits the element selection to Lagrange elements. They force 
the solution variables to be continuous across interior boundaries.

Note: The two-component formulation for the magnetic field requires that µ is 
everywhere continuous. Similarly the two-component formulation for the electric 
field requires that εc is everywhere continuous.

Although Lagrange elements are used, there is no problem with spurious modes for 
this equation formulation.

∇ εrc
1– ∇ H×( )× k0

2µrH– 0=

n– εrc
1– ∇ H×( )1 εrc

1– ∇ H×( )2–[ ]× n jωε0 E1 E2–( )×– 0= =

n2 ε1E1 ε2E2–( )⋅ 0=
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Perfect Magnetic Conductor
The perfect magnetic conductor boundary condition, 

sets the tangential component of the magnetic field to zero at the boundary.

This boundary condition is not available in the two-component hybrid-mode waves 
formulation for E, because it would require a constraint on the second derivative of Et.

Perfect Electric Conductor
The perfect electric conductor boundary condition,

sets the tangential component of the electric field to zero at the boundary.

This boundary condition is not available for the two-component formulation for H, 
because it would require a constraint on the second derivative of Ht.

Continuity
The continuity boundary condition

is the natural boundary condition ensuring continuity of the tangential components of 
the electric and magnetic fields.

S E L E C T I N G  E Q U A T I O N  F O R M U L A T I O N

As has been shown when deriving the equations, the TE, TM, and the two-component 
hybrid-mode waves formulation all have their limitations. Some general guidelines are:

• The TE and TM waves formulations require that the whole geometry consists of 
one single homogeneous medium.

• Some derived quantities, for example the energy, are obtained from the second 
derivative of the dependent variables in the two-component formulation. Therefore 
they might be less accurate than in the three-component formulation.

• The two-component formulation does not allow both the permittivity and 
permeability to be discontinuous. 

n H× 0=

n E× 0=

n H1 H2–( )× 0=

n E1 E2–( )× 0=
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• The two-component formulation does not support the perfect magnetic conductor 
(PMC) and the perfect electric conductor (PEC) boundary conditions.

• The three-component formulation is the only formulation that supports absorbing 
boundaries, perfectly matched layers (PMLs), and impedance boundary conditions.

The following table shows the characteristics of the different equation formulations.

A P P L I C A T I O N  M O D E  V A R I A B L E S

See the section “Perpendicular Waves Application Mode” on page 20 of the RF 
Module Reference Guide.

Boundary Mode Analysis Application Mode in 3D

The Boundary Mode Analysis application mode in 3D treats the same type of 
problems as the Perpendicular Waves application mode in 2D. The type of fields that 
can be described are

The mode analysis can be performed on planar boundaries representing a cross section 
of a waveguide. The coordinates rt span the 2D boundary and n is the outward normal 
to the boundary. The wave propagates in through the boundary.

Analysis Type TYPE DEP. VARIABLES EIGENVALUE DISCONT. ε DISCONT. µ PMC PEC

Eigenmode TE Hz  λ = −jβ √ √

Eigenfrequency TE Hz  λ = −jω √ √

Eigenmode TM Ez  λ = −jβ √ √

Eigenfrequency TM Ez  λ = −jω √ √

Eigenmode Hybrid Hx, Hy, Hz  λ = −jβ √ √ √ √

Eigenmode Hybrid Hx, Hy  λ = −jβ √ √

Eigenfrequency Hybrid Hx, Hy, Hz  λ = −jω √ √ √ √

Eigenfrequency Hybrid Hx, Hy  λ = −jω √ √

Eigenmode Hybrid Ex, Ey, Ez  λ = −jβ √ √ √ √

Eigenmode Hybrid Ex, Ey  λ = −jβ √ √

Eigenfrequency Hybrid Ex, Ey, Ez  λ = −jω √ √ √ √

Eigenfrequency Hybrid Ex, Ey  λ = −jω √ √

H x y z t, , ,( ) H rt( )ej ωt β n r⋅( )+( )
=

E x y z t, , ,( ) E rt( )ej ωt β n r⋅( )+( )
=
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For a homogeneous boundary TE and TM waves are found, while in the general case 
a hybrid-mode wave calculation has to be made.

T E  WAV E S

When the medium is homogeneous TE waves can exist. In this case an equation for 
Hn, the component of the magnetic field normal to the boundary, can be derived,

The operator  is the tangential derivative operator.

T M  W AV E S

Like for TE waves, the TM waves only appears when the medium is homogeneous. An 
equation for the electric field component normal to the boundary can be formulated,

H Y B R I D - M O D E  WA V E S

In the general case with a inhomogeneous medium all field components are nonzero. 
An system of equation can be formulated for either the H field or the E field. Writing 
the equations in terms of the H field they read

Here

For a derivation, see the Perpendicular Waves application on page 141. The equation 
above is only formulated for an isotropic medium.

The corresponding formulation for the electric field is obtained by replacing H by E 
and by interchanging εc and µ.

∇t– εrc
1– ∇tHn( ) µrk0

2Hn–⋅ β2εrc
1– Hn–=

∇t

∇t– µr
1– ∇tEn( ) εrck0

2En–⋅ β2µr
1– En–=

∇t εrc
1– ∇t ht×( ) k0

2µrht–× β2εrc
1– ∇hn k0 ht+⁄( )–=

0 β2 1
k0
------∇t εrc

1– ∇hn k0 ht+⁄( ) µrhn+⋅⎝ ⎠
⎛ ⎞=

ht βHt= hn jk0Hn–=
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A P P L I C A T I O N  M O D E  P R O P E R T I E S

The application mode specific properties are given in the table below.

A P P L I C A T I O N  S C A L A R  V A R I A B L E S

The application-specific variables in this mode are given in the following table.

All values are expressed in SI units.

E D G E  C O N D I T I O N S

At interior edges of the boundary, the conditions

have to be fulfilled. In can be shown that the equations for TE and TM waves do not 
fulfill these conditions at interfaces between different media. Therefore these 
equations only apply to homogeneous media.

Perfect Magnetic Conductor
The perfect magnetic conductor edge condition,

PROPERTY VALUES DESCRIPTION

Field type TE waves 
TM waves 
Hybrid-mode waves

Specifies which type of 
waves to handle.

Specify wave 
using

Frequency 
Free-space wavelength

Specifies if the frequency or 
the wavelength should be 
used as input.

Solve for Electric field 
Magnetic field

Specifies which field is the 
dependent variable.

Specify 
eigenvalues using

Eigenvalue 
Propagation constant 
Effective mode index

Specifies if the solver 
parameters should be given 
in terms of the eigenvalue, 
the effective mode index, or 
the propagation constant.

PROPERTY NAME DEFAULT UNIT DESCRIPTION

µ0 mu0 4*pi*1e-7 H/m Permeability of vacuum

ε0 epsilon0 8.854187817e-12 F/m Permittivity of vacuum

ν nu 1e9 Hz Frequency

λ0 lambda0 0.3 m Free-space wavelength

n2 E1 E2–( )× 0=

n2 H1 H2–( )× 0=
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sets the tangential component of the magnetic field to zero at the edge.

This condition cannot be applied to interior edges when the electric field is the 
dependent variable.

Perfect Electric Conductor
The perfect electric conductor edge condition,

sets the tangential component of the electric field to zero at the edge.

This condition cannot be applied to interior edges when the magnetic field is the 
dependent variable.

Continuity at Interior Edges
The continuity edge condition

is the natural condition ensuring continuity of the tangential components of the 
electric and magnetic fields.

A P P L I C A T I O N  M O D E  V A R I A B L E S

See the section “Boundary Mode Analysis Application Mode in 3D” on page 24 of the 
RF Module Reference Guide.

Boundary Mode Analysis Application Mode in 2D

The Boundary Mode Analysis application mode in 2D treats mode analysis problems 
in 1D. The type of fields that can be described are

The mode analysis can be performed on planar boundaries representing a cross section 
of a waveguide. The coordinates rt span the 1D boundary and n is the outward normal 
to the boundary. The wave propagates in through the boundary.

n H× 0=

n E× 0=

n H1 H2–( )× 0=

n E1 E2–( )× 0=
p

H x y t, ,( ) H rt( )ej ωt β n r⋅( )+( )
=

E x y t, ,( ) E rt( )ej ωt β n r⋅( )+( )
=
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The application mode can also handle axisymmetric waves. These waves have to travel 
in the z direction,

T E  WA V E S

When the medium is homogeneous TE waves can exist. In this case an equation for 
Ez, the component of the magnetic field normal to the boundary, can be derived,

The operator  is the tangential derivative operator.

For axisymmetric TE waves the equation reads

T M  WAV E S

Like for TE waves, the TM waves only appears when the medium is homogeneous. An 
equation for the electric field component normal to the boundary can be formulated,

For axisymmetric TM waves the equation reads

A P P L I C A T I O N  M O D E  P R O P E R T I E S

The application mode specific properties are given in the table below.

PROPERTY VALUES DESCRIPTION

Field type TE waves 
TM waves

Specifies which type of 
waves to handle.

H r z t, ,( ) H r( )ej ωt βz+( )
=

E r z t, ,( ) E r( )ej ωt βz+( )
=

∇t– µr
1– ∇tEz( ) εrck0

2Ez–⋅ β2µr
1– Ez–=

∇t

∂
r∂

----- µr
1– 1

r
--- ∂

r∂
----- rEϕ( )⎝ ⎠

⎛ ⎞– εrck0
2Eϕ– β2µr

1– Eϕ–=

∇t– εr
1– ∇tHz( ) µrk0

2En–⋅ β2εr
1– Hz–=

∂
r∂

----- εrc
1– 1

r
--- ∂

r∂
----- rHϕ( )⎝ ⎠

⎛ ⎞– µrk0
2Hϕ– β2εrc

1– Hϕ–=
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A P P L I C A T I O N  S C A L A R  V A R I A B L E S

The application-specific variables in this mode are given in the following table.

All values are expressed in SI units.

P O I N T  C O N D I T I O N S

At interior points of the boundary, the conditions

have to be fulfilled. It can be shown that the equations for TE and TM waves do not 
fulfill these conditions at interfaces between different media. Therefore these 
equations only apply to homogeneous media.

Perfect Magnetic Conductor
The perfect magnetic conductor point condition,

sets the magnetic field to zero at the point.

This condition is not available for interior edges when the magnetic field is the 
dependent variable.

Specify wave 
using

Frequency 
Free-space wavelength

Specifies if the frequency or 
the wavelength should be 
used as input.

Specify 
eigenvalues using

Eigenvalue 
Propagation constant 
Effective mode index

Specifies if the solver 
parameters should be given 
in terms of the eigenvalue, 
the effective mode index, or 
the propagation constant.

PROPERTY NAME DEFAULT UNIT DESCRIPTION

µ0 mu0 4*pi*1e-7 H/m Permeability of vacuum

ε0 epsilon0 8.854187817e-12 F/m Permittivity of vacuum

ν nu 1e9 Hz Frequency

λ0 lambda0 0.3 m Free-space wavelength

PROPERTY VALUES DESCRIPTION

n2 E1 E2–( )× 0=

n2 H1 H2–( )× 0=

n H× 0=
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Perfect Electric Conductor
The perfect electric conductor point condition,

sets the electric field to zero at the point.

This condition cannot be applied to interior edges when the electric field is the 
dependent variable.

Continuity at Interior Points
The continuity edge condition

is the natural condition ensuring continuity of the tangential components of the 
electric and magnetic fields.

A P P L I C A T I O N  M O D E  V A R I A B L E S

See the section “Boundary Mode Analysis Application Mode in 2D” on page 26 of the 
RF Module Reference Guide.

n E× 0=

n H1 H2–( )× 0=

n E1 E2–( )× 0=
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 5
G l o s s a r y  
This glossary contains finite element modeling terms in an electromagnetic waves 
context. For mathematical terms as well as geometry and CAD terms specific to the 
COMSOL Multiphysics software and documentation, please see the glossary in the 
COMSOL Multiphysics User’s Guide. For references to more information about a 
term, see the index.
 155
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G l o s s a r y  o f  T e rm s
absorbing boundary   A boundary that lets an electromagnetic wave propagate through 
the boundary without reflections.

anisotropy   Variation of material properties with direction.

constitutive relation   The relation between the D and E fields and between the B and 
H fields. These relations depend on the material properties.

cutoff frequency   The lowest frequency for which a given mode can propagate 
through, for example, a waveguide or optical fiber.

edge element   See vector element.

eigenmode   A possible propagating mode of, for example, a waveguide or optical fiber.

electric dipole   Two equal and opposite charges +q and −q separated a short distance 
d. The electric dipole moment is given by p = qd, where d is a vector going from −q 
to +q.

gauge transformation   A variable transformation of the electric and magnetic potentials 
that leaves Maxwell’s equations invariant.

magnetic dipole   A small circular loop carrying a current. The magnetic dipole 
moment is m = IAe, where I is the current carried by the loop, A its area, and e a unit 
vector along the central axis of the loop.

Nedelec’s edge element   See vector element.

perfect electric conductor   A material with high electric conductivity, modeled as a 
boundary where the electric field is zero.

perfect magnetic conductor   A material with high permeability, modeled as a boundary 
where the magnetic field is zero.

phasor   A complex function of space representing a sinusoidally varying quantity.
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quasi-static approximation   The electromagnetic fields are assumed to vary slowly, so 
that the retardation effects can be neglected. This approximation is valid when the 
geometry under study is considerably smaller than the wavelength.

vector element   A finite element often used for electromagnetic vector fields. The 
tangential component of the vector field at the mesh edges is used as a degree of 
freedom. Also called Nedelec’s edge element or just edge element.
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I N D E X

3D electromagnetic waves

application mode 112

A AC/DC Module 5

Ampère’s law 88

analysis

eigenfrequency 108

eigenmode 108

harmonic 108

transient 108

analysis capabilities 107

analysis type 108

anisotropic material 92

antiperiodic boundaries 37

application mode 8, 106

Axisymmetric waves 132

Boundary mode analysis 148, 151

Electromagnetic waves (3D) 112

In-plane hybrid-mode waves 126

In-plane TE waves 124

In-plane TM waves 125

Perpendicular hybrid-mode waves 141

Perpendicular TE waves 140

Perpendicular TM waves 139

application mode properties 109

application mode property

analysis type 115, 127, 143

divergence condition 115

field components 144

field type 127, 143, 149, 152

solve for 115, 143, 149

specify eigenvalues using 115, 127, 144, 

149, 152

specify wave using 115, 127, 143, 149, 

152

application mode variable 110

application scalar variable 109

Application Scalar Variables dialog box 

13, 109

attempt to evaluate real square root of 

negative number

error message 65

attenuation constant 139

axial symmetry 17

boundary condition 137

Axisymmetric waves

application mode 132

B boundary condition 110

axisymmetric 137

impedance 121

matched boundary 120, 130

nonreflecting 120, 130

port 56, 122

surface current 118

transition 121

Boundary mode analysis

application mode 148, 151

Boundary Settings dialog box 13, 109

C Cartesian coordinates 106

circular ports 57

coaxial modes 58

coaxial port shape 68

coaxial ports 57

compatible meshes 85

complex permittivity 111

conductivity 89

Constants dialog box 12

constitutive relation 88

generalized 89

continuity in periodic boundaries 37

current density 88

cutoff frequency
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for waveguide 23

cylindrical coordinates 106

D dependent variables 106

dipole antenna

far-field pattern from 50

dispersive materials 92

E eddy currents 21

Edge Settings dialog box 109

eigenfrequency analysis 7, 108

eigenfrequency calculation 116

eigenmode analysis 108

electric charge density 88

electric conductivity 89

electric dipole moment 89

electric displacement 88

electric energy 90

electric field 88, 106

electric flux density 88

electric polarization 89

electric power 91

electric scalar potential 90

electric susceptibility 89

electrical size 5

Electromagnetic waves

application mode 112

electromagnetic waves 111

perpendicular 139

energy density 92

energy loss

resistive and reactive 91

equation formulations

for perpendicular waves 147

equation of continuity 88

external current 90

F Faraday’s law 88

far-field postprocessing 49, 99

symmetry planes in 50

far-field radiation pattern 50

far-field variables 49

field variables in 2D 7

Floquet periodicity 37

free-space impedance 100

free-space wave number 100, 113

free-space wavelength 116, 144

G Gauss’ law 88

geometric multigrid 69

geometry

simplifying 16

H harmonic analysis 108

H-bend 21

Hermitian transpose

solver setting 20

hierarchy generation method 70

hybrid-mode waves 123

axisymmetric 136

in-plane 126

perpendicular 141

I impedance boundary condition 121

incident field 48

inhomogeneous materials 92

In-plane hybrid-mode waves

application mode 126

In-plane TE waves

application mode 124

In-plane TM waves

application mode 125

interface conditions 93

L line current 123

loss

resistive and reactive 91

lossy eigenvalue calculations 78

lumped ports 67

M magnetic dipole moment 89

magnetic energy 90



magnetic field 88, 106

magnetic flux density 88

magnetic potential 106

scalar 90

vector 90

magnetic power 91

magnetic susceptibility 89

magnetic vector potential 90

magnetization 89

matched boundary condition 43, 120, 130

material library 110

Materials/Coefficients Library dialog box 

12

Maxwell’s equations 88

Maxwell-Ampère’s law 88

mesh resolution 19

mode analysis 7, 80, 139

Model M-file 4

multiphysics models 4

N new features in version 3.4 6

nonlinear eigenfrequency problems 79

nonlinear material 92

nonreflecting boundary 120, 130

Nyquist criterion 69

O ohmic losses 112

P PEC 118

perfect conductor 93

perfect electric conductor 21, 118

perfect magnetic conductor 118

perfectly matched layers 43

with scattered-field formulation 48

periodic boundary conditions 37

solver settings for 74

permeability

of vacuum 89

relative 89

permittivity

complex 111

of vacuum 89

relative 89

perpendicular hybrid-mode waves

application mode 141

selecting equation formulation 147

three-component formulation 141

two-component formulation 142

Perpendicular TE waves

application mode 140

Perpendicular TM waves

application mode 139

phasor 94

photonics 112

Plot Parameters dialog box 109

PMC 118

PML 43

Point Settings dialog box 109

polarization 89

polarization losses 112

port boundary condition 56, 122

port mode shapes 68

port modes 57

ports

lumped 67

power level at ports 57

Poynting vector 91, 96, 100

Poynting’s theorem 91

preconditioner

geometric multigrid 69

propagation constant 24, 139

property

analysis type 115, 127, 143

divergence condition 115

field components 144

field type 127, 143, 149, 152

solve for 115, 143, 149

specify eigenvalues using 115, 127, 144, 
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149, 152

specify wave using 115, 127, 143, 149, 

152

Q quality factor 78

R radiation pattern 50

radiative energy 91

radiative loss 91

rectangular ports 57

refractive index 112

relative permeability 89

relative permittivity 89

remanent displacement 90

remanent magnetic flux density 90

resistive energy 91

RF Module 3.4

new features in 6

S scalar magnetic potential 90

scattered field 116

variables for 48

scattered harmonic propagation 48

scattered-field formulation 48

scattering boundary condition 43, 119, 

130, 137

scattering parameter 56

skin effect

considering when meshing 19

slit boundary conditions 84

Solver Parameters dialog box 13

solver settings 19

for 3D periodic wave problems 74

solver type 108

S-parameter matrix 66

S-parameters 56

calculating 56

plotting vs. frequency 65

variables 63

Stratton-Chu formula 99

Subdomain Settings dialog box 13, 109

surface charge 93

surface current 93

surface current boundary condition 118

susceptibility

electric 89

magnetic 89

symmetric matrices

solver setting 20

symmetry axis condition 137

symmetry planes, in far-field analysis 50

T TE waves

axisymmetric 133

in-plane 124

perpendicular 140

time-average Poynting vector 96

time-dependent analysis 8

TM waves

axisymmetric 135

in-plane 125

perpendicular 139

Touchstone file format 66

transient analysis 8, 108

transition boundary condition 121

transversal electric waves 21

typographical conventions 2

U units 101

use Hermitian transpose

solver setting 20

V variables

application mode 110

application scalar 109

dependent 106

for far-field postprocessing 49

vector elements 113, 126, 145

using in assemblies 84

vector magnetic potential 90



voltage generator 68

voltage input, for ports 67

W wave impedance

TE waves 97

TEM waves 97

TM waves 97

wave number

free space 113

wave reflection 26

waveguide H-bend 21

wavelength 19
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